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PENGANTAR

Puji syukur kehadirat Tuhan Semesta Alam atas segala   nikmatnya sehingga buku ini 

dapat terselesaikan dengan temapat waktu dan memberikan berisikan informasi-informasi 

yang berhubungan dengan informasi yang dapat menambah wawasan kita semua.

Panduan Praktis Desain Jembatan 80 Meter menghadirkan langkah-langkah perencanaan 

secara sistematis, mulai dari penentuan data awal, pembebanan berdasarkan standar nasional, 

analisis struktur, hingga perencanaan elemen utama dan pendukung jembatan. Disusun dengan 

pendekatan teknis yang aplikatif, buku ini memandu pembaca untuk memahami proses desain 

secara terstruktur dan terukur.

Dilengkapi dengan perhitungan rinci, acuan regulasi, serta contoh analisis yang relevan, 

buku ini menjadi referensi praktis bagi mahasiswa teknik sipil, perencana struktur, maupun 

praktisi yang ingin memperdalam pemahaman desain jembatan bentang menengah.

Sebuah panduan yang menjembatani teori dan praktik dalam dunia rekayasa struktur.

Pada penyajiannya, setiap pokok bahasan disajikan lebih ke prinsip-prinsip dasar dari 

setiap topik. Dengan demikian, buku ini disusun secara ringkas untuk setiap topik dan disajikan 

dalam bentuk buku. Buku ini juga menggunakan bahasa yang sekomunikatif mungkin sehingga 

diharapkan mudah dipahami oleh pembaca. Namun demikian, perlu membaca isi materi 

secara cermat, bagian per bagian, dan menuliskan kembali yang terdapat pada setiap pokok 

dan sub- pokok bahasan.

Alhamdulillah, terselesaikannya buku ini tidak lepas dari bantuan berbagai pihak 

yang membantu baik secara moril maupun materil. Untuk itu penulis mengucapkan banyak 

terimakasih. Penulis berharap dengan materi-materi yang tersaji dalam buku ini dapat menjadi 

pembelajaran yang berharga.

Penulis
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Testimoni

Pak Totok adalah seorang akademisi, praktisi yang andal, yang dari dulu beliau tidak kenal 

lelah untuk selalu belajar dan belajar sampai bisa seperti ini dengan perjuangan yang tinggi. 

Untuk menjadi ahli baja, motivasi beliau adalah Prof. Dr. Wiryanto, Guru Besar UPH. Beliau 

menimba ilmu kepada siapa saja tanpa perlu malu bertanya kepada yang lebih muda sekalipun 

karena menurut beliau ilmu itu luas, jadi siapa pun bisa belajar dari mana saja. Dengan bangga, 

kami sebagai keluarga, anak, dan istri beliau merasa bersyukur bahwa semua perlu proses 

yang panjang dan dengan kesabaran kami. Alhamdulillah, beliau bisa jadi dosen, direktur, 

dan asesor. Selamat atas pencapaian beliau sebagai penulis buku tentang struktur buat para 

generasi penerus bangsa, terutama di bidang struktur.

Ibu Suryani - Komisaris PT TAP Rekayasa Struktur 

Ashrafi Raihan Tsaqif - (Putra ke 1, Mahasiswa aktif tahap akhir UMJ)

Muhammad Rizqi Yusuf - (Putra ke 2)
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Panduan Praktis Desain Jembatan Baja  
Bentang 80 Meter

Testimoni Buku

Buku ini merupakan karya yang sangat esensial bagi para praktisi, 
akademisi, maupun mahasiswa teknik sipil yang ingin mendalami 
perancangan infrastruktur jembatan secara komprehensif. Penulis 
berhasil menyajikan materi yang kompleks menjadi alur yang sistematis, 
mulai dari pemahaman dasar tipe-tipe struktur jembatan hingga tahapan 
perancangan teknis yang mendalam sesuai regulasi terbaru.

Kekuatan utama buku ini terletak pada pendekatan praktisnya dalam 
memodelkan struktur rangka baja (truss bridge) menggunakan perangkat 
lunak SAP2000. Penjelasan mendetail mengenai pembebanan, termasuk beban angin, temperatur, 
hingga analisis beban gempa (Response Spectrum) menjadikan buku ini panduan yang sangat relevan 
dengan tantangan teknik di lapangan saat ini.

Sebagai seorang yang bergelut di dunia keteknikan dan kebencanaan, saya melihat buku 
ini tidak hanya mengajarkan cara mendesain jembatan yang kuat secara struktural, tetapi juga 
menekankan pentingnya aspek keselamatan dan keberlanjutan sesuai dengan standar nasional (SNI) 
dan internasional (AASHTO). Kehadiran contoh kasus nyata seperti proyek Jembatan Pangean di 
Kalimantan Utara memberikan gambaran konkret bagi pembaca dalam mengaplikasikan teori ke 
dalam praktik nyata. Saya sangat mengapresiasi kontribusi Ir. Totok Andi Prasetyo, M.T., dan 

Harun Napitupulu, S.T., M.T., dalam memperkaya literatur teknik sipil di Indonesia melalui 

buku ini. Sebuah referensi wajib bagi siapa saja yang berkomitmen mewujudkan infrastruktur 

jembatan yang aman, stabil, dan fungsional.”

Prof. Ir. H. Sarwidi, MSCE., Ph.D., IP-U., ASEAN Eng., APEC Eng. 

Guru Besar Rekayasa Kegempaan Teknik Sipil UII 

Inovator & Inventor Barrataga® & Simutaga®

Pengarah BNPB RI (2009-2025)

Ahli Teknik Bangunan Gedung Jenjang 9/9, Ahli Teknik Jembatan Jenjang 9/9
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Buku Panduan Praktis Desain Jembatan Baja Bentang 80 

Meter merupakan kontribusi akademik yang penting dalam bidang 

rekayasa struktur transportasi, khususnya perencanaan jembatan 

baja. Buku ini menyajikan integrasi yang baik antara konsep teoritis, 

ketentuan standar perencanaan nasional maupun internasional, 

serta implementasi teknis melalui pemodelan struktur berbasis 

perangkat lunak analisis.

Penyusunan materi dilakukan secara sistematis mulai dari 

prinsip dasar perencanaan jembatan, pemahaman sistem struktur, penentuan pembebanan 

sesuai regulasi, hingga tahapan pemodelan dan analisis struktur. Pendekatan berbasis studi 

kasus nyata memberikan nilai tambah akademik karena mampu menjembatani kesenjangan 

antara teori di lingkungan pendidikan tinggi dan praktik rekayasa di lapangan.

Dengan kedalaman materi serta penyajian yang aplikatif, buku ini sangat layak digunakan 

sebagai referensi pembelajaran bagi mahasiswa teknik sipil, bahan pendukung perkuliahan 

struktur jembatan, maupun rujukan awal bagi praktisi dalam memahami proses desain 

jembatan baja secara sistematis dan terstruktur.

Ir.M. Aswanto.,MT 

Dosen Senior Universitas Muhammadiyah Jakarta (UMJ) 

Selamat dan sukses saya ucapkan kepada Ir. Totok Andi 

Prasetyo, M.T., AU HAKI IPU, ASEAN. Eng., atas terbitnya buku ke-

7-nya. Buku yang berjudul Panduan Praktis Desain Jembatan Baja 

Bentang 80 Meter ini menjadi sumbangsih di dunia akademik yang 

penting dalam bidang ketekniksipilan.  Konten pada buku teks ini 

tidak hanya menjelaskan secara teori tentang jembatan, tetapi juga 

menjabarkan secara detail peraturan atau standar yang dijadikan 

acuan, pemodelan struktur, pembebanan, serta langkah-langkah 

mendesain dan menganalisis jembatan baja bentang panjang menggunakan software. Harapan 

besar semoga buku ini dapat menjadi rujukan dalam mendesain jembatan baja bentang 

panjang.  

Dr. Abdul Rochim, ST., MT. 

Dekan Fakultas Teknik, Universitas   Islam Sultan Agung 
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Tidak banyak referensi mengenai buku panduan praktis 

jembatan baja rangka bentang panjang 80 meter. Kami sangat yakin 

buku akan menambah pengetahuan  dan kompetensi para engineer 

di dalam dunia Teknik sipil terima kasih pada penulis sudah berbagi 

Semoga Tuhan memberkati Pak Totok Andi Prasetyo 

Ir Herman Sapar

Dosen Senior FTSP UNTAN Ketua LSP ASBSI ATBG Jenjang  9

Saya menyambut dengan gembira terbitnya buku ini, yang 

merupakan lanjutan dari buku-buku sebelumnya yang ditulis oleh 

Bapak Ir. Totok A. Prasetyo dan tim. Suatu kehormatan bagi saya 

untuk kembali memberikan testimoni atas buku ini. Saya sangat 

mengapresiasi penulis yang di tengah kesibukan beliau berkarya 

sebagai insinyur profesional masih menyempatkan waktu dan tenaga 

untuk membagikan ilmunya melalui buku-buku yang diambil dari 

pengalaman pekerjaannya. 

Berbeda dengan buku-buku sebelumnya yang membahas desain struktur gedung, buku 

ini membahas desain struktur jembatan jalan raya. Buku ini dimulai dengan penjelasan singkat 

mengenai jembatan secara umum, kemudian dilanjutkan dengan contoh perhitungan desain 

suatu jembatan baja secara detail. Saya yakin buku ini akan sangat bermanfaat bagi mahasiswa 

yang belajar desain struktur jembatan dan bagi para insinyur muda yang mulai berkarya dalam 

bidang desain. 

Wong Foek Tjong, S.T., M.T., Ph.D. 

Dosen Senior Struktur Baja Universitas Kristen Petra Surabaya

Selamat dan sukses pada Bapak Totok Andi Prasetyo atas 

terbitnya buku Panduan Praktis Desain Jembatan Baja Bentang 80 

m. Buku semacam ini merupakan jembatan antara standar-standar 

teknis yang berlaku dan para tenaga ahli konstruksi di lapangan dan 

calon. Penggunaan piranti lunak dalam panduan juga merupakan 

pelengkap penting yang menjembatani cara klasik desain dengan 

aplikasi praktis yang saat ini niscaya sudah menjadi kebutuhan 

efisiensi proses.   Penerbitan ini diharapkan akan terus memacu 

terbitnya buku-buku panduan praktis selanjutnya, untuk mendukung pembinaan sumber daya 

manusia konstruksi Indonesia, agar dapat menjadi tuan rumah di negeri sendiri.

DR. Ir. Hari Nugraha Nurjaman,MT

Ahli Teknik Bangunan Gedung Utamav
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BAB I

PENDAHULUAN

1.1	 Pengertian Jembatan

Berdasarkan Surat Edaran Menteri PUPR No.7/SE/M/2015, pengertian umum dari 

jembatan adalah bangunan pelengkap jalan yang terputus oleh sungai, saluran, lembah 

dan selat atau laut, jalan raya dan jalan kereta api. Selain itu, Peraturan Menteri PUPR 

No.41/PRT/M/2015 mengatakan bahwa jembatan adalah jalan yang terletak di atas 

permukaan air dan/atau permukaan tanah. Beberapa variasi lalu lintas pada jembatan 

dapat mencakup pejalan kaki, kendaraan, saluran pipa, kabel, air, kereta api, maupun 

kombinasi dari komponen-komponen individual tersebut.

Diskontinuitas yang ada dapat berupa jalan raya (highway), sungai, lembah, 

ataupun berbagai macam hambatan fisik lainnya. Layaknya jalan raya ataupun sistem 

drainase, jembatan merupakan sebuah bagian yang krusial dalam jaringan transportasi 

yang pastinya merupakan bagian dari sebuah perancangan tata kota atau wilayah.

1.2	 Perencanaan Teknis

Peraturan Menteri PUPR No.05/PRT/M/2015 mengatakan bahwa perencanaan 

teknis adalah kegiatan yang berupa proses pemikiran, kreasi, dan perekayasaan dalam 

rangka mewujudkan infrastruktur. Sumber yang lain yaitu Peraturan Pemerintah No.34 

Tahun 2006 menyatakan bahwa perencanaan teknis adalah kegiatan penyusunan 

dokumen rencana teknis yang berisi gambaran produk yang ingin diwujudkan yang 

harus dilakukan secara optimal dengan memperhatikan aspek lingkungan hidup. Sebuah 

jembatan harus dalam kondisi aman, stabil, fungsional, ekonomis dan indah. Latar 

belakang dalam dibuatnya perencanaan teknis jembatan agar penyelenggara jalan dapat 

mewujudkan:

1.	 Tertib penyelenggaraan jalan yang meliputi pengaturan, pembinaan, pembangunan 

dan pengawasan jalan dan

2.	 Tersedianya jalan yang mewujudkan keselamatan, keamanan, kelancaran, ekonomis, 

kenyamanan dan ramah lingkungan.

1.3	 Tahapan Perancangan Teknis Pada Jembatan

Tahapan perancangan teknis jembatan telah dimuat dalam Peraturan Menteri PU 

No.19/PRT/M/2011. Adapun 3 tahap perancangan yang diatur, yaitu
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1.3.1	Perancangan Teknis Awal

Tahap pertama dalam perancangan teknis awal adalah menentukan alternatif 

alignment jalan yang akan dibangun. Alternatif alignment tersebut bertujuan untuk 

memilih skematis terbaik dari beberapa pilihan alignment yang telah direncanakan. 

Tahap kedua adalah melakukan pertimbangan teknis, ekonomis, lingkungan, dan 

keselamatan yang diajukan dari tahap perancangan teknis awal untuk memastikan 

kelayakan dari ketiga pertimbangan yang disyaratkan dalam Peraturan Menteri 

tersebut.

1.3.2	Kajian Kelayakan Jalan

Tahap kedua adalah kajian kelayakan jalan yang terdiri dari kajian kelayakan 

teknis dan kajian kelayakan finansial untuk setiap alternatif alignment  jalan yang 

dikeluarkan pada perencanaan teknis awal dan penetapan pilihan alternatif yang 

paling layak, baik secara teknis maupun finansial serta keselamatan lalu lintas jalan.

1.3.3	Perancangan Teknis Akhir

Bagian ini terdiri dari desain pendahuluan terpilih hasil dari kajian kelayakan 

jalan, Detail Engineering Design, Audit Keselamatan Jalan (AKJ) dan perancangan 

teknis akhir.

Ketiga tahapan tersebut harus dilaksanakan dalam perencanaan jembatan 

agar mutu pekerjaan terjaga sesuai dengan Surat Edaran Menteri dan Peraturan 

Menteri.

1.4	 Peraturan dan Standar yang Dijadikan Acuan

Adapun beberapa peraturan dan standar yang digunakan dalam perancangan 

jembatan baja bentang 80 meter ini yaitu:

1.	 Peraturan Pemerintah No.34 Tahun 2006 tentang Jalan;
2.	 Peraturan Menteri PU No.19/PRT/M/2011 tentang Persyaratan Teknis Jalan dan 

Kriteria Perencanaan Teknis Jalan;
3.	 Peraturan Menteri PUPR No.05/PRT/M/2015 tentang Pedoman Umum Implementasi 

Konstruksi Berkelanjutan Pada Penyelenggaraan Infrastruktur Bidang Pekerjaan 
Umum dan Pemukiman;

4.	 Peraturan Menteri PUPR No.41/PRT/M/2015 tentang Penyelenggaraan Keamanan 
Jembatan dan Terowongan Jalan;

5.	 UU No.02 Tahun 2017 tentang Jasa Konstruksi;
6.	 SE Menteri PUPR No.07/SE/M/2015 tentang Pedoman Persyaratan Umum 

Perencanaan Jembatan;
7.	 SNI 1725:2016 tentang Pembebanan Untuk Jembatan;
8.	 SNI 2833:2016 tentang Perencanaan Jembatan Terhadap Beban Gempa;
9.	 SNI 8460:2017 tentang Persyaratan Perancangan Geoteknik;
10.	RSNI T-12-2004 tentang Perencanaan Struktur Beton Untuk Jembatan;
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11.	RSNI T-03-2005 tentang Perencanaan Struktur Baja Untuk Jembatan;
12.	AASHTO LRFD Bridge Design Specifications, 6th Edition, 2012;
13.	AASHTO Guide Specifications for Design and Construction of Segmental;
14.	Concrete Bridge, 2nd Edition, 1999 PCI Design Handbook, dan
15.	International Building Code, IBC, 2006.

1.5	 Umur Rencana Jembatan

Pada umumnya, umur rencana jembatan berkisar antara 50 tahun, sedangkan 

jembatan khusus bisa sampai 100 tahun. Umur rencana jembatan permanen adalah 50 

tahun. Umur rencana tersebut biasanya dipengaruhi oleh bahan/material yang digunakan 

dan aksi di lingkungan sekitarnya yang dianggap memengaruhi durabilitas jembatan 

tersebut. Untuk jembatan dengan umur rencana yang lebih panjang harus direncanakan 

untuk aksi yang mempunyai periode ulang lebih panjang menurut persamaan di bawah.

Pr = 1 + (1 - (1/R))D

Di mana:

Pr	 = 	Kemungkinan bahwa aksi tertentu akan terlampaui minimal sekali selama 		

		  umur rencana jembatan yang ditetapkan;

D	 = 	Umur rencana jembatan yang ditetapkan (tahun) dan

R	 = 	Periode ulang dari aksi beban yang diperhitungkan (tahun)

1.6	 Rencana Keadaan Batas

Rencana keadaan batas adalah pendekatan perencanaan di mana semua fungsi 

dan bentuk struktur telah diperhitungkan. Pada saat mencapai keadaan batas jembatan 

diasumsikan, terdapat sejumlah reaksi yang sedemikian besarnya sehingga mengakibatkan 

jembatan runtuh/tidak layak layan atau telah terjadinya kegagalan (failure). Secara 

sederhana, rencana keadaan batas dapat dirumuskan dengan persamaan di bawah.

Faktor Reduksi Kekuatan x Kapasitas Nominal ≥ Faktor Beban x Beban Nominal
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1.7	 Beberapa Macam Bentang Jembatan

Berikut adalah beberapa macam bentang untuk jembatan.

Tabel 1.1 Beberapa Bentang Jembatan

(Sumber: SE Menteri PUPR No.7/SE/M/2015)

Apabila tidak direncanakan secara khusus, maka dapat digunakan bangunan atas 

jembatan standar Bina Marga (gambar standar) sesuai bentang ekonomis dan kondisi lalu 

lintas air di bawahnya seperti:

1.	 Box Culvert (single, double, triple) bentang 6-10 meter;
2.	 Voided Slab bentang 6-12 meter;
3.	 Voided Slab bentang 6-16 meter;
4.	 Gelagar Beton Bertulang Tipe T bentang 6-20 meter;
5.	 Gelagar Beton Pratekan Tipe I bentang 16-60 meter;
6.	 Gelagar Beton Pratekan Tipe T bentang 30-60 meter;
7.	 Girder Komposit Tipe I bentang 20-60 meter;
8.	 Girder Komposit Tipe Box bentang 20-60 meter, dan
9.	 Rangka Baja bentang 40-100 meter.

1.8	 Klasifikasi Jembatan

1.8.1 Berdasarkan Tipe Struktur

Jembatan dapat diklasifikasikan berdasarkan aksi gaya yang bekerja, misalnya 

gaya tarik, tekan, lentur, torsi dan geser terdistribusi sepanjang sistem struktur 

jembatan. Dalam menahan dan meneruskan beban yang bekerja ke fondasi 

jembatan sebagian besar tipe jembatan akan mengalami hampir seluruh gaya-gaya 

ini, namun beberapa gaya/aksi akan lebih dominan dibandingkan dengan gaya/aksi 

yang lainnya. Berdasarkan tipe struktur jembatan dapat diklasifikasikan menjadi:

•	 Jembatan pelat (slab bridge);

•	 Jembatan gelagar (girder bridge);

•	 Jembatan rangka batang (truss bridge);
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•	 Jembatan pelengkung (arch bridge);

•	 Jembatan balok pelengkung (tied arch bridge);

•	 Jembatan gantung (suspension bridge) dan

•	 Jembatan beruji kabel (cable-stayed bridge)

1.8.1.1 Jembatan Pelat (Slab Bridge)

Jembatan pelat (slab bridge) adalah jembatan yang terdiri dari pelat 

yang ditumpu oleh kepala jembatan pada kedua ujungnya. Jenis jembatan ini 

pada umumnya mempunyai bentang yang pendek. Adapun kelebihan dari 

jembatan tipe ini adalah metode pelaksanaan konstruksinya yang mudah dan 

cepat dibandingkan dengan jembatan tipe yang lainnya, karena jembatan ini 

mempunyai sistem struktur yang sederhana. Tulangannya tersebar merata 

tanpa adanya konsentrasi penulangan pada area gelagar.

Gambar 1.1 Slab Brige

1.8.1.2 Jembatan Gelagar (Girder Bridge)

Jembatan gelagar tersusun dari gelagar horizontal yang ujung-ujungnya 

tertumpu pada struktur bawah jembatan dan biasanya tumpuan tersebut 

adalah tumpuan sederhana, di mana jembatan hanya menghubungkan satu 

bentang tunggal atau sebagai jembatan yang menerus di mana gelagar tersebut 

membentang secara menerus melewati beberapa titik tumpuan (jembatan 

bentang majemuk). Gaya vertikal pada jembatan gelagar ditransfer menjadi 

gaya geser dan lentur pada elemen gelagar yang kemudian diteruskan ke bagian 

tumpuan jembatan. Jembatan gelagar umumnya mempunyai balok yang 

berbentuk I, T, dan boks. Bentang maksimum yang diizinkan dari jembatan 

gelagar umumnya sebesar 75 meter, karena semakin besarnya tegangan lentur 

dan defleksi yang diakomodir seiring makin panjangnya bentang jembatan.
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Gambar 1.2 Girder Bridge

1.8.1.3 Jembatan Rangka Batang (Truss Bridge)

Jembatan rangka batang adalah jembatan yang di mana elemen-

elemennya berupa elemen batang yang bekerja melalui mekanisme aksial 

yang berupa tekan dan tarik. Jembatan ini merupakan salah satu tipe jembatan 

tertua yang masih ada dan masih banyak digunakan pada era modern 

sekarang ini. Jembatan rangka batang merupakan jembatan dengan bentang 

yang ekonomis karena kita dapat memanfaatkan material penampang secara 

maksimal.

Gambar 1.3 Truss Bridge
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1.8.1.4 Jembatan Pelengkung (Arch Bridge)

Jembatan pelengkung merupakan jembatan yang bentuknya setengah 

lingkaran di mana pada kedua ujungnya bertumpu di kepala jembatan 

(abutment). Konsep utama dari jembatan tipe ini adalah mengubah gaya 

dalam akibat beban-beban luar yang bekerja pada jembatan yang umumnya 

berupa gaya dalam berupa momen lentur dan gaya geser pada jembatan 

pelengkung menjadi gaya tekan murni pada busur dengan memanfaatkan 

geometri jembatan.

Gaya tekan ini diteruskan sepanjang busur menjadi gaya lateral dan 

vertikal pada kepala jembatan. Dahulu kala, jembatan pelengkung banyak 

ditemui karena jembatan ini dapat dibuat dari material seperti batuan ataupun 

beton tanpa tulangan yang umumnya memiliki ketahanan yang bagus terhadap 

tekan namun lemah terhadap tarik.

Gambar 1.4 Arch Bridge

1.8.1.5 Jembatan Balok Pelengkung (Tied Arch Bridge)

Jembatan balok pelengkung memiliki komponen struktur atas yang 

bentuknya melengkung namun memiliki satu fitur berbeda dengan jembatan 

pelengkung pada umumnya terkait elemen pengikat yang menghubungkan 

kedua tumpuan jembatan. Elemen pengikat ini berfungsi untuk membantu 

menahan gaya lateral yang seharusnya diakomodasi oleh tumpuan jembatan 

dalam bentuk tarik pada elemen pengikat tersebut. Sistem ini menghasilkan 

desain fondasi dari elemen kepala jembatan yang lebih optimal dan ekonomis.
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Gambar 1.5 Tied Arch Bridge

1.8.1.6 Jembatan Gantung (Suspension Bridge)

Jembatan gantung merupakan sistem struktur jembatan di mana lantai 

jembatan ditumpu melalui kabel gantung. Struktur jembatan terbuat dari baja 

kecuali bagian lantai jembatan/gelagar dan fondasi. Menara dibuat dari baja 

atau beton bertulang. Berikut segi ekonomis dari jembatan gantung.

•	 Kabel parabolik sebagai elemen utama yang didukung sedemikian sehingga 

menyalurkan beban ke menara dan jangkar berupa tegangan tarik langsung;

•	 Ketahanan tarik ultimate yang tinggi dari kabel dan penggantung sehingga 

berat sendiri struktur ekonomis dalam pencapaian bentang panjang;

•	 Kabel utama diperkaku oleh rangka pengaku atau sistem gelagar pada 

elevasi lantai. Sistem pengaku menahan gerakan aerodinamis dan 

membuat perubahan sudut setempat dalam lantai yang mana bukan 

menjadi masalah bila berat sendiri besar;

•	 Lantai digantung dengan penggantung kabel sehingga seluruh struktur 

dapat dibangun tanpa perancah mengingat urutan pelaksanaannya yang 

dimulai dari menara, kabel, penggantung lalu ke lantai;

•	 Tinggi menara perlu dibatasi bila lokasi berdekatan dengan lapangan udara 

dan

•	 Biaya struktur utama yang terdiri dari kabel, penggantung dan menara 

dapat diperkirakan pada awal desain karena beban mati dan hidup melalui 

penggantung (tarik) dipikul oleh kabel (tarik) dan disalurkan ke menara.
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Gambar 1.6 Suspension Bridge

1.8.1.7 Jembatan Beruji Kabel (Cable-Stayed Bridge)

Cable-stayed bridge juga ditopang oleh kabel-kabel, namun pada sistem 

cable-stayed ini jumlah kabel yang dibutuhkan lebih sedikit dan elemen tower/

pylon yang difungsikan untuk menggantungkan kabel pada umumnya memiliki 

dimensi yang lebih besar dibandingkan tower pada jembatan gantung. Sistem 

cable-stayed ini menghasilkan suatu ruang yang terdiri dari balok-balok 

pengaku (stiffening girder), lantai jembatan baja atau beton bertulang, dan 

bagian-bagian pendukung seperti pilon yang bereaksi pada tekanan, dan 

kabel-kabel miring yang bereaksi pada tegangan.

Karakteristik utama dari sistem cable-stayed adalah aksi yang integral 

dari balok-balok pengaku dan prestressed ataupun post-tensioning cable yang 

berjalan turun dari puncak menara ke titik-titik angkur pada balok pengaku. 

Kuat tekan secara horizontal yang diakibatkan aksi kabel diambil alih oleh 

balok-balok pengaku dan angkur-angkur yang tidak masif yang sangat 

diperlukan. Karakteristik struktural lainnya dari sistem cable-stayed adalah 

bahwa sistem ini secara geometris tidak berubah di bawah pembebanan pada 

berbagai posisi di jembatan dan seluruh kabel berada dalam posisi tegang.
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Gambar 1.7 Cable-Stayed Bridge

1.8.1.8 Jembatan Kantilever

Jembatan kantilever adalah jenis jembatan yang dibangun dengan 

prinsip struktur kantilever (balok terjepit di satu ujung dan bebas di ujung 

lainnya), di mana setiap sisi bentang utama (main span) dibangun secara 

bertahap dari tumpuan tetap (pier) ke arah tengah tanpa bantuan tumpuan 

sementara di tengah sungai atau lembah. Konstruksi dimulai dari dua sisi 

berlawanan, masing-masing berupa lengan kantilever yang menonjol dari pier 

utama, hingga akhirnya bertemu di tengah bentang dan disambung dengan 

sendi (hinge) atau sambungan kaku. Sistem ini memungkinkan pembangunan 

jembatan di atas jurang dalam, sungai lebar, atau wilayah dengan akses sulit 

tanpa memerlukan perancah (falsework) di bawahnya, sehingga sangat efisien 

untuk bentang panjang (100–500 m). Material utama biasanya beton prategang 

atau baja, dengan gelagar kotak (box girder) sebagai penampang utama untuk 

meningkatkan kekakuan torsional dan mengurangi lendutan.
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Gambar 1.8 Struktur Jembatan Kantilever

1.9	 Struktur Atas Jembatan

Struktur atas jembatan merupakan seluruh bagian jembatan yang berada di atas 

tumpuan utama (pier/abutment) dan berfungsi langsung menerima serta menyalurkan 

beban lalu lintas ke struktur bawah. Komponen utama struktur atas meliputi lantai 

jembatan (deck/slab), balok utama (main girder/longitudinal girder), balok lintang (cross 

girder/diaphragm), sistem pengaku (bracing), serta elemen tambahan seperti trotoar, pagar 

pengaman, dan sambungan ekspansi. Dek jembatan dapat berupa pelat beton bertulang, 

pelat beton prategang, atau sistem komposit baja-beton (steel-concrete composite), 

sedangkan balok utama bisa berbentuk I, box girder, atau rangka baja tergantung jenis 

dan bentang jembatan.

Fungsi utama struktur atas adalah mendistribusikan beban mati (berat sendiri 

jembatan) dan beban hidup (kendaraan, pejalan kaki, angin, gempa) secara merata ke 

tumpuan-tumpuan di bawahnya dengan faktor keamanan yang tinggi. Desain struktur atas 

sangat menentukan jenis jembatan secara keseluruhan. Kekakuan, ketahanan terhadap 

kelelahan, dan kemudahan perawatan menjadi pertimbangan utama dalam pemilihan 

sistem struktur atas modern

1.9.1. Pelat Lantai

Pelat lantai jembatan berfungsi sebagai penahan lapisan perkerasan yang 

menahan langsung beban lalu lintas yang melewati jembatan. Komponen ini 

merupakan komponen yang menyalurkan beban langsung lalu ditransfer ke main 

girder.
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Gambar 1.9 Pelat Lantai Jembatan

1.9.2 Trotoar

Trotoar berfungsi sebagai tempat untuk pejalan kaki dan terletak di sisi kiri. 

Trotoar biasanya terdapat pada struktur jembatan yang menopang jalan raya dan 

biasanya dilengkapi dengan railing dan kerb.

Gambar 1.10 Trotoar Jembatan

1.9.3 Cross Girder

Cross girder merupakan balok melintang yang letaknya di bawah balok 

memanjang (stringer). Fungsi dari cross girder adalah menerima beban dari stringer 

dan pelat lantai di atas stringer. kemudian disalurkan ke rangka utama. Cross girder 

tersebut diletakkan searah dengan aliran sungai.
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Gambar 1.11 Cross Girder Jembatan

1.9.4 Balok Stringer

Stringer merupakan balok yang menerima transfer beban dari pelat lantai. 

Letaknya tegak lurus terhadap aliran sungai dan menumpu pada cross girder.

Gambar 1.12 Stringer Jembatan
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1.9.5 Main Frame

Main frame merupakan rangka utama di mana fungsinya untuk menahan 

semua beban, baik secara langsung atau beban yang ditransfer untuk diterusan ke 

pier atau abutment jembatan. Rangka ini terdiri dari top chord, bottom chord, batang 

vertikal dan batang diagonal (tergantung tipe jembatan).

Gambar 1.13 Main Frame Jembatan

1.9.6 Bracing

Ikatan angin (bracing) merupakan batang yang berfungsi untuk pengaku lateral 

jembatan (biasanya berpola silang di bagian atas jembatan) dan menyalurkan gaya 

yang diakibatkan oleh angin ke perletakan jembatan dan menjaga keseimbangan 

jembatan.

Gambar 1.14 Bracing Jembatan

1.9.7 Elastomer

Elastomer (elastic polymer) atau bridge bearing biasanya terbuat dari bahan 

karet karena sifat elastisnya yang dapat meredam getaran jembatan dan sebagai 

media untuk menyalurkan beban ke pier/abutment. Elastomer pada umumnya 

dipasang di atas pier head atau di bawah girder atau di atas abutment.

Gambar 1.15 Elastomer
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1.9.8 Lateral Buffer

Lateral buffer merupakan suatu penahan yang dirancang untuk membatasi 

gerakan berlebih jembatan ke arah tegak lurus sumbu memanjang jalan. Berikut 

adalah 3 kegunaan lateral buffer:

1.	 Menjaga agar rangka jembatan tetap berada pada posisinya (tidak bergeser dari 
tumpuan/bearing);

2.	 Menahan gaya angin dari samping;
3.	 Menahan gaya sentrifugal (jika ada) dan
4.	 Menahan gaya gempa yang bekerja dalam arah lateral.

1.9.9 Longitudinal Buffer

Longitudinal buffer merupakan suatu penahan yang dirancang untuk 

membatasi gerakan berlebih jembatan searah sumbu memanjang jalan. Berikut 

adalah 3 kegunaan longitudinal buffer:

1.	 Menahan gaya rem kendaraan yang bekerja sejajar sumbu arah memanjang 
jalan;

2.	 Membatasi pergerakan yang diakibatkan oleh muai dan susut oleh suhu agar 
tidak menabrak dinding backwall abutment dengan keras dan

3.	 Menahan gaya gempa yang bekerja dalam arah longitudinal.

1.10	 Struktur Bawah Jembatan

1.10.1 Abutment

Abutment merupakan struktur penyangga utama yang terletak di kedua ujung 

jembatan, berfungsi sebagai tumpuan akhir bagi struktur atas (superstructure) 

sekaligus penahan tanah timbunan pendekat jembatan (approach embankment). 

Abutment menerima seluruh beban vertikal dan horizontal dari bentang jembatan, 

kemudian menyalurkannya ke tanah fondasi di bawahnya. Secara umum, abutment 

terdiri dari dinding depan (breast wall), dinding sayap (wing wall), dinding belakang 

(back wall), serta fondasi (footings atau tiang pancang). Material yang paling sering 

digunakan adalah beton bertulang, meskipun pada jembatan kecil kadang masih 

ditemukan abutment pasangan batu atau beton siklop.
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Gambar 1.16 Abutment Jembatan

1.10.2  Pier

Pier atau pilar merupakan sebuah kolom pada jembatan yang didesain untuk 

meneruskan semua beban, baik vertikal maupun horizontal kepada fondasi di 

bawahnya.

Gambar 1.17 Pier Jembatan

1.10.3 Pile Cap

Pile cap merupakan elemen struktural krusial pada konstruksi jembatan yang 

berfungsi untuk mengikat kumpulan fondasi tiang (pile group) menjadi satu kesatuan 

yang kaku. Fungsi utamanya adalah mendistribusikan beban terpusat yang berasal 

dari pilar atau abutment jembatan secara merata ke seluruh tiang fondasi yang ada 

di bawahnya. Selain sebagai penyalur beban, pile cap juga berperan penting dalam 

menjaga stabilitas posisi tiang-tiang tersebut agar tidak terjadi pergeseran lateral 

maupun penurunan yang tidak seragam (differential settlement), sehingga struktur 

bangunan atas tetap berada pada elevasi rencana.
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Dalam proses perancangannya, pile cap harus memiliki ketebalan dan 

penulangan yang cukup untuk menahan gaya geser serta momen lentur yang sangat 

besar. Dimensi pile cap biasanya ditentukan berdasarkan jumlah tiang, jarak antar 

tiang, serta besarnya beban aksial dan lateral dari bangunan atas jembatan. Material 

yang digunakan umumnya berupa beton bertulang dengan mutu tinggi untuk 

memastikan durabilitas jangka panjang, mengingat posisi pile cap sering kali berada 

di bawah permukaan tanah atau terendam air yang rentan terhadap risiko korosi 

dan degradasi lingkungan.

Berdasarkan SNI 2847:2019, tebal efektif pile cap jika diukur dari tulangan 

bawah yaitu sebesar 300 mm, dan fV
n
 ≥ V

u
 baik untuk satu arah maupun dua arah.

Gambar 1.18 Pile Cap

1.10.4 Tiang fondasi

Fondasi merupakan elemen struktur paling bawah yang berfungsi menyalurkan 

seluruh beban jembatan (beban mati, beban hidup, gempa, angin, dan tumbukan) ke 

lapisan tanah atau batuan yang memiliki daya dukung memadai. Fondasi jembatan 

dibagi menjadi dua kategori besar, yaitu fondasi dangkal (shallow foundation) 

dan fondasi dalam (deep foundation). Fondasi dangkal berupa footing spread atau 

raft hanya digunakan pada jembatan kecil hingga sedang bila tanah keras berada 

dekat permukaan dan penurunan diperkirakan kecil. Namun, mayoritas jembatan 

modern, terutama yang melintasi sungai, rawa, atau tanah lunak, menggunakan 

fondasi dalam seperti tiang pancang (driven pile), bored pile, caisson, atau barrette 

untuk mencapai lapisan keras di kedalaman 20–100 meter atau lebih
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Gambar 1.19 Tiang fondasi/Pancang
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BAB II

PEMODELAN STRUKTUR

2.1	 Data Umum Bangunan

Pada buku ini akan diberikan contoh langsung pemodelan struktur jembatan baja.

Berikut adalah data umum jembatan:

a.	 Nama proyek		  :  Jembatan Pangean;
b.	 Lokasi proyek		  :  Kalimantan Utara;
c.	 Panjang jembatan		  :  80 meter;
d.	 Lebar jembatan		  :  7,6 meter;
e.	 Luas jembatan		  :  xxx m2 , dan
f.	 Sistem struktur		  :  Rangka Baja

Data-data di atas adalah informasi umum dalam merancang jembatan. Penulis 

menggunakan sebuah software yang memang dikhususkan untuk menganalisis struktur 

rangka baja, yaitu SAP2000.

Gambar 2.1 Software SAP2000

2.2	 Pemodelan Struktur Atas

2.2.1 Pembuatan Grid

Sebelum membuat sebuah grid/AS jembatan tersebut, ada baiknya kita 

mengetahui bagaimana site plan/tata letak bangunannya. 
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Gambar 2.2 Site Plan Jembatan

Klik menu File → New Model, pilih opsi Grid Only. Selain itu juga terdapat 

beberapa pilihan lain yang bisa digunakan dalam membuat grid. Akan tetapi pada 

buku ini penulis memilih yang opsi Grid Only.

Gambar 2.3 Opsi Grid Pada Software SAP2000
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Gambar 2.4 Quick Grid Lines

Setelah itu kita perlu menyesuaikan jarak grid sesuai dengan gambar arsitektur. 

Caranya klik kanan pada salah satu jendela SAP2000 lalu pilih Edit Grid Data.

Gambar 2.5 Edit Grid Data
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Gambar 2.6 Coordinate/Grid Systems

Gambar 2.7 Grid yang Telah Dibuat

2.2.2 Pembuatan Properti Material

Setelah kita membuat grid bangunan, maka selanjutnya adalah menentukan 

properti material yang akan digunakan untuk merancang struktur jembatan ini. 

Material yang digunakan di antaranya:

a.	 Baja

Cara membuat properti material tersebut di atas adalah dengan memilih 

menu Define, pilih opsi Materials.
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Gambar 2.8 Define Material Properties

Gambar 2.9 Define Materials
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Adapun penentuan properti material yang akan dirancang harus mengikuti 

ketentuan di bawah.

a.	 Baja

Data:

Massa jenis		  = 7.850 kg/m3;

Kuat leleh (fy)		  = 355 MPa;

Kuat tarik (fu)		  = 490 MPa;

Poisson ratio		  = 0,3

Modulus		  = 200.000 MPa

   Gambar 2.10 Material Property Data

2.2.3 Pembuatan Properti Penampang

Dalam merancang suatu bangunan, pastilah kita harus menentukan/membuat 

beberapa penampang seperti penampang pelat, balok dan kolom. Adapun beberapa 

ukuran penampang baja yang digunakan penulis dalam merancang jembatan ini 

adalah sebagai berikut:

a.	 Balok baja

H 800x500x14x24

H 450x500x20x30

H 450x480x20x30
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H 450x450x20x30

H 450x400x20x30

H 450x400x20x20

H 450x350x20x30

H 450x350x20x24

H 450x350x20x20

H 450x350x10x20

H 450x350x10x16

H 450x300x20x20

H 450x300x10x12

H 440x300x12x14

Sebagai sample penulis akan mengambil salah satu balok baja di atas. Caranya 

adalah klik menu Define → Section Properties → Frame Sections. Lalu klik Add New 

Property → Frame Section Property Type: Steel.

Gambar 2.11 Frame Sections

Gambar 2.12 I/Wide Flange Section



26

2.2.4 Pemodelan Balok

Setelah membuat penampang balok baja selanjutnya kita akan memodelkan balok.

a.	 Memodelkan balok

Pemodelan elemen balok baja dimulai dari elevasi bottom jembatan, di 

mana pada elevasi ini akan dilewati oleh banyak kendaraan. Caranya klik ikon 

xy pada toolbar SAP2000 dan pastikan berada pada elevasi Z=0.

Gambar 2.13 Bottom Plan View

Gambar 2.14 Draw Frame
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Gambar 2.15 Balok yang Sudah Termodelkan Pada elevasi Bottom

Hal yang serupa dapat diterapkan untuk elevasi top jembatan. Pastikan SAP 

menunjukkan elevasi xy pada Z=8000.

Gambar 2.16 Balok yang Sudah Termodelkan Pada Elevasi Top

Untuk membuat side frame klik ikon xz dan gambar frame jembatannya.

Gambar 2.17 Side Frame

2.2.5 Hasil Pemodelan Dalam Tiga Dimensi

Setelah memodelkan semua balok, baik dalam elevasi bottom, top dan side 

frame, berikut ini adalah model dalam bentuk 3 dimensinya.
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Gambar 2.18 Model Dalam Tiga Dimensi

2.2.6 Melepaskan Momen Pada Frame

Setelah memodelkan seluruh rangka baja pada jembatan ini, perlu diketahui 

bahwa kita harus melepaskan/release momen pada beberapa balok pada frame. 

Moment release adalah pembebasan/pelepasan momen pada kedua ujung balok, 

sehingga ujung elemen balok tersebut menjadi sendi (hinge) sehingga tidak mampu 

menerima momen. Gunanya agar tidak terjadinya momen tambahan pada balok 

baja, terutama balok diagonal dan stringer. Dan momen akan dilimpahkan ke balok 

yang tidak di-release. Perlu diperhatikan untuk moment release pada masing-masing 

bagian dimulai dari bottom sampai dengan top.

Pada bagian bottom semua balok stringer harus dilepas momennya, sehingga 

select semua balok stringer lalu klik menu Assign → Releases/Partial Fixity, lalu 

centang pada bagian Moment 22, Moment 33 dan Torsion.
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Gambar 2.19 Frame Moment Releases

Gambar 2.20 Assign Frame Releases and Partial Fixity

Gambar 2.21 Moment Release Pada Bagian Bottom

Setelah melakukan pelepasan momen pada bagian bottom, lakukan hal yang 

serupa pada bagian side frame dan top.
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Gambar 2.22 Moment Relese Pada Side Frame

Gambar 2.23 Moment Release Pada Top

Gambar 2.24 Overall Moment Release
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BAB III

PEMBEBANAN

3.1	 Pembebanan Struktur Atas

3.1.1 Beban Mati

Menurut SNI 1725:2016 tentang Pembebanan Pada Jembatan, beban mati 

adalah semua beban tetap yang berasal dari berat sendiri jembatan atau bagian 

jembatan yang ditinjau, termasuk segala unsur tambahan yang dianggap merupakan 

satu kesatuan tetap dengannya.

3.1.1.1 Beban Mati Primer

Beban mati primer adalah berat sendiri pelat dan sistem lainnya yang 

dipikul langsung oleh tiap-tiap gelagar jembatan

3.1.1.2 Beban Mati Sekunder

Beban mati sekunder adalah berat kerb, trotoar, tiang sandaran dan lain-

lain yang dipasang setelah pelat dicor. Beban tersebut dianggap terbagi rata di 

seluruh gelagar.

3.1.2 Beban Hidup

Beban hidup adalah semua beban yang berasal dari berat kendaraan-

kendaraan bergerak/lalu lintas dan/atau pejalan kaki yang dianggap bekerja pada 

jembatan.

3.1.3 Beban Khusus

Beban khusus adalah beban yang merupakan beban-beban khusus untuk 

perhitungan tegangan pada perencanaan jembatan.

3.1.4 Beban Lalu Lintas

Beban lalu lintas adalah seluruh beban hidup, arah vertikal dan horizontal, 

akibat aksi kendaraan pada jembatan, termasuk hubungannya dengan pengaruh 

dinamis, tetapi tidak termasuk akibat tumbukan.

3.1.5 Beban Pelaksanaan

Beban pelaksanaan adalah beban sementara yang dapat bekerja pada 

bangunan secara menyeluruh atau sebagian selama pelaksanaan.
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3.2	 Perincian Beban Mati Pada Struktur Atas

Berikut adalah pembebanan pada jembatan yang terdiri dari beban mati (MS) dan 

beban mati tambahan (MA).

Gambar 3.1 Beban Mati yang Bekerja

3.3	 Perincian Beban Hidup Pada Struktur Atas

Berikut ini adalah beban hidup yang bekerja di struktur jembatan yang berupa 

beban pejalan kaki.
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Gambar 3.2 Beban TP

3.4	 Beban Kendaraan

3.4.1 Beban Truk T

Berikut ini adalah beban kendaraan yang bekerja yang bekerja pada struktur 

jembatan.

Gambar 3.3 Beban Kendaraan Truk T

3.4.2 Beban Terbagi Rata (BTR)

Berikut adalah beban terbagi rata (BTR) yang bekerja pada struktur jembatan.

Gambar 3.4 Beban Terbagi Rata
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3.4.3 Beban Garis Terpusat (BGT)

Berikut adalah beban garis terpusat (BGT) yang bekerja pada struktur jembatan.

Gambar 3.5 Beban Garis Terpusat

3.4.4 Beban Rem

Berikut adalah beban rem yang bekerja pada struktur jembatan.

Gambar 3.6 Beban Rem Per Joint

3.5	 Beban Angin

3.5.1 Tekanan Angin Horizontal

Tekanan angin horizontal ditentukan oleh angin rencana dengan kecepatan 

dasar (V
B
) sebesar 90 km/jam hingga 126 km/jam. Beban angin harus diasumsikan 

terdistribusi secara merata pada permukaan yang terekspos oleh angin. Luas area 

yang diperhitungkan adalah luas area dari semua komponen, termasuk sistem lantai 

dan railing yang diambil tegak lurus terhadap arah angin. Arah ini harus divariasikan 

untuk mendapatkan pengaruh yang paling berbahaya terhadap struktur jembatan 

atau komponen-komponennya. Luasan yang tidak memberikan kontribusi dapat 

diabaikan dalam perencanaan.

Untuk jembatan atau bagian jembatan dengan elevasi lebih tinggi dari 10000 

mm di atas permukaan tanah atau permukaan air, kecepatan angin rencana, V
DZ

, 

harus dihitung dengan persamaan sebagai berikut
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Keterangan:

Tabel 3.1 Nilai V
0
 dan Z

0
 Untuk Berbagai Variasi Kondisi Permukaan Hulu

(Sumber: SNI 1725:2016 Tabel 28)

Gambar 3.7 Tekanan Angin Horizontal

3.5.2 Beban Angin Pada Struktur (EWs)

Jika dibenarkan oleh kondisi setempat, perencana dapat menggunakan 

kecepatan angin rencana dasar yang berbeda untuk kombinasi pembebanan yang 

tidak melibatkan kondisi beban angin yang bekerja pada kendaraan. Arah angin 

rencana harus diasumsikan horizontal, kecuali ditentukan lain dalam SNI 1725:2016 

Pasal 9.6.3. Dengan tidak adanya data yang lebih tepat, tekanan angin rencana dalam 

MPa dapat ditetapkan dengan menggunakan persamaan sebagai berikut
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Keterangan:

P
B
	 = Tekanan angin dasar seperti yang ditentukan dalam SNI 1725:2016 Tabel 29

Tabel 3.2 Tekanan Angin Dasar

(Sumber: SNI 1725:2016 Tabel 29)

Gambar 3.8 Beban Angin Pada Struktur (EWs)

3.5.3 Beban Angin Pada Kendaraan (EWL)

Tekanan angin rencana harus dikerjakan baik pada struktur jembatan 

maupun pada kendaraan yang melintasi jembatan. Jembatan harus direncanakan 

memikul gaya akibat tekanan angin pada kendaraan, di mana tekanan tersebut 

harus diasumsikan sebagai tekanan menerus sebesar 1,46 N/mm, tegak lurus dan 
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bekerja 1800 mm di atas permukaan jalan. Kecuali jika ditentukan di dalam pasal 

ini, jika angin yang bekerja tidak tegak lurus struktur, maka komponen yang bekerja 

tegak lurus maupun paralel terhadap kendaraan untuk berbagai sudut serang dapat 

diambil seperti yang ditentukan dalam SNI 1725:2016 Tabel 31 di mana arah sudut 

serang ditentukan tegak lurus terhadap arah permukaan kendaraan.

Tabel 3.3 Komponen Beban Angin yang Bekerja Pada Kendaraan

(Sumber: SNI 1725:2016 Tabel 31)

Gambar 3.9 Beban Angin Pada Kendaraan (EW
L
)

3.6	 Beban Temperatur

Beban temperatur adalah gaya internal atau deformasi yang terjadi pada struktur 

jembatan akibat perubahan suhu lingkungan (panas matahari, malam dingin, musim 

hujan/kemarau). Perubahan suhu menyebabkan pemuaian (expansion) atau penyusutan 

(contraction) material, yang jika terkekang akan menghasilkan tegangan tekan atau tarik 

besar.
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3.7	 Koordinat Lokasi Proyek

Untuk membuat function response spectrum, terlebih dahulu kita mengetahui di 

mana lokasi proyek ini dan berapa koordinatnya. Setelah kita mengetahui lokasi dan 

koordinat tersebut kita bisa mencari nilai parameter kegempaan lainnya.

Gambar 3.10 Koordinat Lokasi Proyek

3.8	 Nilai PGA Berdasarkan Lokasi Proyek

Gambar 3.11 Nilai PGA



39

3.9	 Nilai Ss Berdasarkan Lokasi Proyek

Gambar 3.12 Nilai Ss

3.10	 Nilai S1 Berdasarkan Lokasi Proyek

Gambar 3.13 Nilai S1

3.11	 Parameter Gempa

Tabel 3.4 Parameter Gempa
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3.12	 Input Parameter Gempa Response Spectrum di SAP2000

Setelah kita mengetahui parameter gempa yang diperlukan, maka selanjutnya kita 

melakukan input sebagai Response Spectrum di SAP2000. Caranya adalah klik Define → 

Functions → Response Spectrum. Klik Add New Function sesuai gambar di bawah.

Gambar 3.14 Define Response Spectrum Functions

Sesuaikan masing-masing nilai parameter gempa seperti yang telah ditentukan 

sebelumnya.

Gambar 3.15 Input Nilai Response Spectrum

3.13	 Membuat Load Pattern

Untuk membuat pola pembebanan/load pattern, terlebih dahulu kita harus 

mengetahui simbol-simbol apa saja yang digunakan untuk beban. Berikut adalah simbol-

simbol yang digunakan untuk beban yang bersumber dari SNI 1725:2016 Pasal 5.8.
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Gambar 3. 16 Simbol Beban Permanen

Gambar 3.17 Simbol Beban Transien

Tabel 3.5 Load Pattern yang Dibuat
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3.14	 Membuat Load Cases

Setelah membuat load pattern selanjutnya adalah membuat load cases, caranya 

adalah klik menu Define → Load Combination → Add New Load Case lalu sesuaikan 

dengan yang diperlukan.

Gambar 3.18 Load Cases yang Telah Dibuat

3.15	 Membuat Load Combination

Untuk membuat kombinasi pembebanan/load combination, bisa mengacu ke SNI 

1725:2016 Tabel 1 Kombinasi Beban dan Faktor Beban. Berikut adalah tabel kombinasi 

pembebanan yang dijadikan acuan untuk membuat kombinasi pembebanan di SAP2000.

Tabel 3.6 Kombinasi Pembebanan dan Faktor Beban

(Sumber: SNI 1725:2016 Tabel 1)
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Setelah mengetahui kombinasi pembebanan apa saja yang harus dibuat di software 

SAP2000, selanjutnya adalah klik menu Define → Load Combination → Add New Combo 

lalu sesuaikan dengan yang diperlukan.

Tabel 3.7 Summary of Load Combination

3.16	 Assign Pembebanan

3.16.1 Beban Mati dan Beban Mati Tambahan Pada Struktur (MS dan MA)

Setelah menghitung beban mati dan beban mati tambahan apa saja yang 

bekerja pada struktur, baik pada balok utama maupun balok stringer, selanjutnya 

melakukan assign sesuai pada lokasi di mana beban tersebut bekerja (apakah balok 

utama atau balok stringer). Berikut adalah salah satu contoh beban mati berupa 

beban metal deck yang akan di-assign. Caranya, klik balok di mana beban itu bekerja 

(pada kasus ini adalah balok stringer), lalu klik Assign → Frame Loads → Distributed, 

lalu sesuaikan nilainya dengan perhitungan yang telah dilakukan sebelumnya.

Gambar 3.19 Frame Distributed Loads
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Gambar 3.20 Input Nilai Frame Distributed Load

Gambar 3.21 Nilai Beban Metal Deck yang Telah Diinput

3.16.2 Beban Pejalan Kaki (TP)

Beban pejalan kaki yang ditentukan sesuai SNI 1725:206 adalah sebesar 5 

kN/m2. Setelah itu kita assign sesuai lebar pedestriannya. Untuk melakukan assign 

beban pejalan kaki, caranya klik Assign → Frame Loads → Distributed lalu sesuaikan 

nilainya dengan perhitungan yang telah dilakukan sebelumnya. Lakukan assign di 

balok pada tepi jembatan, karena pedestrian berada pada tepi jembatan.
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Gambar 3.22 Nilai Beban Pejalan Kaki yang Telah Diinput

3.16.3 Beban Truk T (TT)

Untuk assign beban truk (TT) ini agar cukup hati-hati dan teliti di mana beban 

gandar/AS roda ini nantinya akan bekerja pada balok stringer ataupun balok girder. 

Karena di sini diasumsikan beban gandar truk bekerja pada balok stringer, maka 

akan dilakukan input beban truk pada balok stringer. Beban pada roda truk akan 

dimodelkan sebagai beban titik pada balok stringer.

Untuk melakukan input beban roda pada jembatan, caranya klik menu Assign 

→ Frame Loads → Point. Perhatikan baik-baik untuk melakukan assign pada balok 

stringer, di sini harus dilakukan pada segmen yang paling kritis, yaitu di tengah-

tengah bentang (lihat SNI 1725:2016 Pasal 8.4.2).

Gambar 3.23 Beban Roda Truk yang Telah Diinput
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3.16.4 Beban Terbagi Rata (BTR)

Beban terbagi rata (BTR) atau juga beban lajur D pada jembatan harus di assign 

pada sisi memanjang jembatan. Nilainya tergantung dari seberapa panjang bentang 

jembatan yang akan didesain. Pada perhitungan sebelumnya telah dilakukan 

perhitungan pada beban terbagi rata (BTR) jembatan ini.

Beban terbagi rata (BTR) di-assign pada balok stringer yang mewakili suatu jalur 

pada jembatan. Caranya klik Assign → Frame Loads → Distributed lalu sesuaikan 

nilainya dengan perhitungan yang telah dilakukan sebelumnya.

Gambar 3.24 Beban Terbagi Rata (BTR) yang Telah Diinput

3.16.5 Beban Garis Terpusat (BGT)

Pada subbab sebelumnya kita telah melakukan perhitungan untuk mengetahui 

nilai dari beban garis terpusat (BGT). Beban ini harus di-assign di tengah-tengah 

bentang jembatan untuk mendapatkan momen lentur negatif maksimum pada 

jembatan. Untuk melakukan assign beban garis terpusat (BGT) klik Assign → 

Frame Loads → Distributed lalu sesuaikan nilainya dengan perhitungan yang telah 

dilakukan sebelumnya.



47

Gambar 3.25 Beban Garis Terpusat (BGT) yang Telah Diinput

3.16.6 Beban Rem

Untuk beban rem, penulis mengacu pada RSNI-T-02-2005 Pasal 6.7. Gaya 

rem yang didapat dari pembacaan grafiknya adalah sebesar 196 kN. Gaya-gaya itu 

bekerja pada semua titik buhul pada jembatan sesuai dengan perhitungan yang 

telah dilakukan sebelumnya. Gaya rem bekerja sejajar dengan arah memanjang 

jembatan. Untuk menginput gaya rem pada SAP2000, caranya: select semua titik 

buhul jembatan, lalu klik menu Assign → Joint Loads → Forces, lalu masukkan 

nilainya sesuai dengan perhitungan yang telah dilakukan sebelumnya.

Gambar 3.26 Beban Rem yang Telah Diinput

3.16.7 Beban Angin Pada Struktur (EWs)

Beban angin pada struktur yang bekerja di semua profil jembatan dikategorikan 

menjadi 2, yaitu tekan dan isap. Pada perhitungan sebelumnya, telah diketahui 

masing-masing nilai untuk angin tekan dan isap pada semua profil baja. Untuk 

melakukan assign nilai beban angin pada struktur caranya adalah select salah satu side 

frame untuk angin tekan dan side frame yang lain untuk angin isap lalu klik Assign → 

Frame Loads → Distributed. Untuk hasilnya bisa dilihat pada gambar di bawah.
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Gambar 3.27 Beban Angin Pada Struktur yang Telah Diinput

3.16.8 Beban Angin Pada Kendaraan (EWL)

Tekanan angin rencana harus dikerjakan baik pada struktur jembatan 

maupun pada kendaraan yang melintasi jembatan. Jembatan harus direncanakan 

memikul gaya akibat tekanan angin pada kendaraan, di mana tekanan tersebut 

harus diasumsikan sebagai tekanan menerus sebesar 1,46 N/mm, tegak lurus dan 

bekerja 1800 mm di atas permukaan jalan. Untuk melakukan assign beban angin 

pada kendaraan caranya pilih semua joint jembatan lalu klik Assign → Joint Loads → 

Forces. Berikut adalah nilai beban angin pada kendaraan yang telah diinput.

Gambar 3.28 Beban Angin Pada Kendaraan yang Telah Diinput

3.16.9 Beban Temperatur

Untuk menginput beban temperatur, caranya dengan select semua frame 

jembatan, lalu Assign → Frame Loads → Temperature, lalu masukkan perbedaan 

suhu sesuai SNI 1725:2016 Tabel 18. Berikut adalah nilai beban temperatur pada 

frame yang telah diinput.
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Gambar 3.29 Beban Temperatur yang Telah Diinput

3.17	 Pembebanan Struktur Bawah

ti = Tebal lapisan tanah i Tanah Keras = N-SPT ≥ 50
Ni = Nilai N-SPT pada lapisan ke i Tanah Sedang = 15 ≤ N-SPT < 50

Tanah Lunak = N-SPT < 15

Depth (m) N-SPT (Ni) ti (m) ti/Ni Depth (m) N-SPT (Ni) ti (m) ti/Ni
0 0 0 0.00 0 0 0 0.00
2 5 2 0.40 2 5 2 0.40
4 2 2 1.00 4 3 2 0.67
6 3 2 0.67 6 13 2 0.15
8 4 2 0.50 8 21 2 0.10
10 20 2 0.10 10 50 2 0.04
12 18 2 0.11 12 50 2 0.04
14 5 2 0.40 14 50 2 0.04
16 9 2 0.22 16 50 2 0.04
18 50 2 0.04 18 50 2 0.04
20 50 2 0.04 20 50 2 0.04
22 50 2 0.04 22 50 2 0.04

22 3.52 24 50 2 0.04
6.25 26 50 2 0.04

Jenis Tanah = Tanah Lunak 28 50 2 0.04
30 50 2 0.04

22 1.76
12.53

Jenis Tanah = Tanah Lunak
Kelas Situs = E

Rata-rata

PENENTUAN KELAS SITUS

BH-1 BH-2

Total
Rata-rata

Total
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Untuk penentuan respon spektra di permukaan tanah, diperlukan suatu faktor amplifikasi
untuk PGA, periode pendek (T=0,2 detik) dan periode 1 detik. Faktor amplifikasi meliputi
faktor amplifikasi getaran terkait percepatan pada batuan dasar (FPGA), faktor amplifikasi
periode pendek (Fa) dan faktor amplifikasi terkait percepatan yang mewakili getaran periode
1 detik (Fv)

Percepatan puncak pada batuan dasar PGA = 0.136 g
Percepatan periode pendek pada batuan dasar Ss = 0.265 g
Percepatan 1 detik pada batuan dasar S1 = 0.073 g

Nilai diambil dari Desain Spektra Indonesia

Faktor amplifikasi pada batuan dasar FPGA = 2.212
Faktor amplifikasi pada periode pendek Fa = 2.452
Faktor amplifikasi pada periode 1 detik Fv = 3.5

PENENTUAN KELAS SITUS

Respon spektra di permukaan tanah ditentukan dari 3 (tiga) nilai percepatan puncak yang
mengacu pada peta gempa Indonesia dengan probabilitas terlampaui 7% dalam 75 tahun
(PGA, SS dan S1), serta nilai faktor amplifikasi FPGA, Fa, dan Fv. Perumusan respon spektra
adalah sebagai berikut :

Koefisien percepatan puncak permukaan As = FPGA PGA = 0.3008
Percepatan spektra di permukaan pada periode pendek SDS = Fa Ss = 0.6498

SD1 = Fv S1 = 0.2555

Setiap jembatan harus ditetapkan dalam salah satu empat zona gempa berdasarkan spektra 
percepatan periode 1 detik (SD1)

Zona Gempa = 2

Untuk periode lebih kecil dari T0, koefisien respons gempa elastik (Csm) didapatkan dari
persamaan berikut :
Koefisien respons gempa elastik

Ts SD1/SDS = 0.3932
T0 0,2 Ts = 0.0786

Gaya per satuan unit P0 = 1 kN/m
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Perpindahan struktur akibat beban 1 satuan arah longitudinal
δ long = ((P Habt

3)/(3 Ec I)) + ((P 1,2 Habt)/(0,4 Ec Pabt Babt)) = 1.45442E-06 m/kN
Kekakuan arah longitudinal Klong = 1/δ long = 687559.0797 kN/m
Perpindahan statis di arah longitudinal vs(x) = (P0 Lb)/Klong = 0.1164 mm

Perhitungan faktor α, β, dan γ  dan periode getar natural struktur
Berat total struktur atas W = Wu / L = 25.4705 kN/m
Perhitungan periode struktur α	=	vs L	= 0.0093 m2

β	=	α	W	= 0.2371 kNm
γ	=	β	vs = 0.0000 kNm2

Τ	=	2	π	(γ	/	(P g α)) = 0.1092 s
Koefisien respon gempa elastis Csm = 0.6498
Gaya gempa statik ekivalen Pelong = (β Csm / γ) W vs = 16.5502 kN/m
Faktor modifikasi respon R = 2
Gaya gempa akibat struktur atas Hlong = Pelong L / R = 662.0095 kN
yang dipikul abutmen

Gaya gempa akibat berat sendiri abutment dan tekanan tanah belakang abutment di atas pile cap 
Berat abutment Wabt = 1764.1728 kN
Gaya gempa akibat berat abutment Habt = 0,5 As Wabt = 265.3598 kN
Luas timbunan tanah di atas pile cap Atim = 16756000 mm2

Berat tekanan tanah di atas pile cap Wtim = γs Pabt Atim = 3136.7232 kN
Gaya gempa akibat berat tekanan tanah Htim = 0,5 As Wtim = 471.8134 kN
belakang abutment di atas pile cap
Gaya gempa di dasar abutment PIR = Habt + Htim = 737.1732 kN

Gaya gempa akibat tekanan tanah aktif gempa
Sudut geser internal tanah ϕ = 35
Koefisien percepatan vertikal Kv = 0
Koefisien percepatan horizontal Kh = 0,5 As = 0.150
Sudut geser diantara tanah dan abutment δ = 0
Sudut kemiringan timbunan i = 0
Kemiringan dinding abutment terhadap bidang vertikal β = 0

θ = arctan (Kh/(1-Kv)) = 8.554
ψ = = 2.275

Koefisien tekanan aktif seismik KAE = = 0.36

Berdasarkan persamaan Mononobe-Okabe, tekanan tanah aktif gempa dihitung sebagai berikut:
Tekanan tanah gempa aktif PAE = 1/2 γs H2 (1-Kv) KAE Pabt = 1294.6604 kN
Gaya bekerja pada ketinggian 0,6 H diiatass pilecap
Total beban gempa pada abutment ΣH = H + PIR + PAE = 2693.8430 kN
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Perhitungan beban gempa arah longitudinal dengan memperhitungkan friksi tumpuan
Pada kasus ini tumpuan move yang digunakan adalah tipe elastomer, maka
berdasarkan SNI 2833:2008, koefisien gesek elastomer adalah:
Koefisien gesek elastomer µ = 0.18
Karena bentang kiri ditumpu oleh tumpuan fix dan move, maka beban gempa arah
longitudinal terhadap tumpuan move dihitung dengan pengaruh friksi.
Berat struktur Wu = 2037.642 kN
Reaksi vertikal pada abutment RW = 0,5 Wu = 1018.821 kN
Panjang total gelagar berat yang berkontribusi menjadi gaya inersia L = 80 m

W = Wu / L = 25.4705 kN/m
Perhitungan periode struktur α	=	vs L	= 0.0093 m2

β	=	α	W	= 0.2371 kNm
γ	=	β	vs = 0.0000 kNm2

Τ	=	2	π	(γ	/	(P g α)) = 0.1092 s
Koefisien respon gempa elastis Csm = 0.6498
Gaya inersia bangunan atas pada abutment 
dengan pengaruh friksi HA = Csm Wu -µ RW = 1140.631 kN
Faktor modifikasi respon R = 1.5
Gaya gempa akibat struktur atas yang dipikul abutment Hlong = HA/R = 760.421 kN

Berat sendiri (self weight ) adalah berat  bahan dan bagian jembatan yang merupakan elemen struktural,  
ditambah dengan elemen non-struktural yang dipikulnya dan bersifat tetap. Berat sendiri dibedakan
menjadi  2 macam, yaitu berat  sendiri struktur atas, dan berat  sendiri struktur bawah.

Beban Sendiri Struktur Atas (MS)
Beban rangka jembatan = 2037.642 kN
Tebal pelat beton untuk lajur kendaraan = 0.25 m
Jarak antar balok stringer = 1.1 m
Berat jenis beton = 24 kN/m3

Berat per meter = 6.6 kN/m
Beban pelat beton lajur kendaraan = 1584 kN
Tebal pelat beton untuk trotoar = 0.5 m
Lebar beton trotoar = 0.5 m
Berat jenis beton = 24 kN/m3

Berat per meter = 6 kN/m
Beban pelat beton trotoar = 480 kN
Berat Struktur Atas Wu = 4101.64 kN

Beban Mati Sendiri (MS)
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Beban Sendiri Struktur Bawah (MS)
Luas potongan melintang abutment Aabt = 7068000 mm2

Luas potongan melintang pilecap Apc = 8400000 mm2

Berat jenis beton γc	= 24 kN/m3

Panjang abutment Pabt = 10400 mm
Panjang pilecap Ppc = 12200 mm
Berat abutment Wabt = Aabt*Pabt*γc = 1764.173 kN
Berat pilecap Wpc = Apc*Ppc*γc = 2459.52 kN
Berat struktur bawah Wb = Wabt + Wpc = 4223.693 kN
Berat total struktur W = Wb + Wu = 8325.335 kN

Reaksi tumpuan struktur atas yang bekerja pada abutment RvMS = Wu / 2 = 2050.821 kN
Gaya dalam akibat beban mati di dasar abutment
Gaya vertikal VMS1 = Wabt + RVMS = 3814.994 kN
Gaya dalam akibat beban mati di dasar pilecap
Gaya vertikal VMS2 = Wb + RVMS = 6274.514 kN

Beban mati tambahan (superimposed dead load),  adalah berat  seluruh bahan  yang menimbulkan
suatu beban pada  jembatan  yang   merupakan elemen  non-struktural, dan mungkin besarnya
berubah selama umur jembatan. Jembatan  dianalisis harus  mampu memikul beban tambahan 

Beban Mati Tambahan Struktur Atas (MA)
Beban aspal

tebal aspal = 0.05 m
lebar jalan = 6 m
berat jenis aspal = 22 kN/m3

berat per meter = 6.6 kN/m
Beban handrail

pipa 88,9 mm x 5,49 mm x 2 bh = 0.23 kN/m
jarak antara balok stringer = 6.67 m
beban per titik = 1.5341 kN

Beban Total MA WMA= 564.8184 kN

Reaksi tumpuan struktur atas yang bekerja pada abutment RvMA = WMA / 2 = 282.4092 kN
Gaya dalam akibat beban mati di dasar abutment
Gaya vertikal VMS1 = RVMA = 282.4092 kN
Gaya dalam akibat beban mati di dasar pilecap
Gaya vertikal VMS2 = RVMA = 282.4092 kN

Beban Mati Tambahan (MA)
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Tanah dibelakang dinding biasanya mendapatkan beban tambahan yang bekerja akibat beban lalu lintas
beban tambahan yang setara dengan tanah setebal 0.7 m yang bekerja secara merata
pada bagian tanah yang dilewati oleh beban lalu lintas. Tekanan tanah lateral dihitung berdasarkan harga
nominal dari berat  tanah γs, sudut  gesek dalam  φ, dengan :

Berat jenis tanah γs = 18 kN/m³
Sudut gesek dalam φ = 30 °
Koefisien tekanan tanah aktif Ka = tan² (45° - φ' / 2) = 0.333333
Beban tambahan γeq = 12.6 kN/m2

Tinggi tanah ke dasar abutment H' = 6.23 m
Tinggi tanah ke dasar pilecap H = 7.92 m

Tekanan tanah aktif di dasar abutment Pa1 = 0,5 (H')2  γs Ka = 116.4387 kN
Gaya dalam akibat tekanan tanah di dasar abutment
Gaya horizontal HTA1 = Pa1 Pabt = 1210.962 kN
Momen Mpa1 = 1/3 H' HTA1 = 2514.765 kNm

Tekanan tanah aktif di dasar pilecap Pa2 = 0,5 (H)2  γs Ka = 188.1792 kN
Gaya dalam akibat tekanan tanah di dasar pilecap
Gaya horizontal HTA2 = Pa2 Ppc = 2295.786 kN
Momen MPa1= 1/3 H' HTA2 = 6060.876 kNm

TEKANAN TANAH AKTIF (TA)

Beban ekivalen kendaraan di abutment (oprit) Peq1 = γeq H' Ka = 26.166 kN
Gaya dalam akibat beban oprit di dasar abutment
Gaya horizontal HPeq1 = Peq1 Pabt = 272.1264 kN
Momen pada abutment akibat beban ekivalen kendaraan Meq1 = Hpeq1 1/2 H' = 847.674 kNm

Beban ekivalen kendaraan di pilecap Peq2 = γeq H Ka = 33.264 kN
Gaya dalam akibat beban oprit di dasar pilecap
Gaya horizontal HPeq2 = Peq2 Ppc = 405.8208 kN
Momen pada pondasi akibat beban ekivalen kendaraan Meq2 = Peq 1/2 H' = 1607.050 kNm

BEBAN TAMBAHAN (PS)

Luas potongan melintang timbunan tanah Atim = 16006000 mm2

Eksentrisitas timbunan di belakang abutment etim = 2099 mm
Beban timbunan di dasar abutment PTA'abt = 0 kN
Beban timbunan di dasar pilecap PTA'pc = γs Pabt Atim = 2996.323 kN
Gaya dalam akibat timbunan di dasar pilecap
Gaya vertikal VTA' = PTA'pc = 2996.323 kN
Momen MTA' = 1/2 VTA' etim = 3144.641 kNm

BEBAN TANAH DIBELAKANG ABUTMENT DIATAS PILECAP (TA')
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Berdasarkan perhitungan sebelumnya, beban gempa yang didapatkan sebagai berikut

Gaya gempa akibat struktur atas yang bekerja diatas abutment Hlong = 760.421 kN
Titik tangkap ke dasar abutment h1 = 4.850 m
Titik tangkap ke dasar pondasi h2 = 6.250 m
Momen akibat gaya gempa di dasar abutment MEQ1 = Hlong h1 = 3688.041 kNm
Momen akibat gaya gempa di dasar pilecap MEQ_PC1 = Hlong h2 = 4752.630 kNm

BEBAN GEMPA (EQ)

Gaya gempa akibat berat sendiri abutment dan tekanan tanah dibelakang diatas pilecap
Total berat struktur bawah PIR = 737.173 kN
Koefisien percepatan puncak permukaan As = 0.301
Gaya gempa akibat berat struktur bawah Wb = 4223.693 kN
Berat akibat tekanan tanah diatas pilecap Htot = 0,5 As Wb = 635.311 kN
Gaya gempa akibat berat tekanan tanah diatas pilecap Wtim = Atim Ppc	γs = 3679.618 kN
Gaya gempa di dasar pilecap Htim = 0.5  As	wtim = 553.473 kN
Gaya gempa di dasar abutment PIRtotal = Htot + Htim = 1188.784 kN
Tinggi titik massa ke dasar abutment h3 = 2.815 m
Tinggi titik massa ke dasar pilecap h4 = 4.263 m
Momen akibat gaya gempa di dasar abutment MEQ2 = PIR h3 = 2075.142 kNm
Momen akibat gaya gempa di dasar pilecap MEQ_PC2 = PIRtotal h4 = 5067.788 kNm

Gaya akibat tekanan tanah aktif gempa
Tekanan tanah aktif gempa di dasar abutment PAE1 = 1294.660 kN
Koefisien tekanan aktif seismik KAE = 0.356
Koefisien percepatan vertikal Kv = 0.000
Tekanan tanah aktif gempa pada dasar abutment PAE2 = 1/2 γs Htot

2 (1-Kv) KAE Pabt = 2092.330 kNm
Tinggi titik tangkap ke dasar abutment h5 = 6.230 m
Tinggi titik tangkap ke dasar pilecap h6 = 7.630 m

Gaya gempa tekanan tanah aktif bekerja pada ketinggian 0.6H, sehingga
Momen akibat gaya gempa di dasar abutment MEQ3 = PAE1 0.6 h5 = 4839.440 kNm
Momen akibat gaya gempa di dasar pilecap MEQ_PC3 = PAE2 0.6 h6 = 9578.685 kNm
Total gaya gempa yang bekerja di dasar abutment Σ Habt = Hlong1 + PIR + PAE1 = 2792.254 kN

Σ Mabt = MEQ1 + MEQ2 + MEQ3 = 11667.213 kNm
Total gaya gempa yang bekerja di dasar pilecap Σ Hpc = Hlong1+PIRtotal + PAE2 = 4041.535 kN

Σ Mpc = MEQ_pc1 + MEQ_pc2 + MEQ_pc3 = 19399.103 kNm
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Beban lajur "D" terdiri atas beban terbagi rata (BTR) yang digabung dengan beban garis (BGT) seperti terlihat dalam 
Gambar 24. Adapun faktor beban yang digunakan untuk beban lajur "D" seperti pada Tabel 12.

Beban terbagi rata (BTR) mempunyai intensitas q kPa dengan besaran q tergantung pada panjang total yang  dibebani L
yaitu seperti berikut :

q = 9.0 kPa untuk L ≤ 30 m
q = 9,0 *  (0,5 + 15 / L) kPa untuk L > 30 m

Lebar bersih jembatan B = 6 m
Panjang jembatan L = 80 m
Jumlah as antar gelagar ng = 6
Jarak as antar gelagar (balok stinger) sg = 1.1 m
Beban terbagi merata q = 6.1875 kPa
Beban BTR WBTR = q sg = 6.80625 kN/m
Beban BTR yang bekerja disemua lajur PBTR = q B L = 2970 kN/m

BEBAN LAJUR "D" (TD)

Keterangan: 
q  : adalah intensitas beban terbagi rata (BTR) dalam arah memanjang jembatan  (kPa) 
L  : adalah panjang total jembatan yang dibebani (meter) 

Beban garis terpusat (BGT) dengan intensitas p kN/m harus ditempatkan tegak lurus terhadap arah lalu lintas pada jembatan. 
Besarnya intensitas p adalah 49,0 kN/m. Untuk mendapatkan momen lentur negatif maksimum  pada jembatan menerus, 
BGT kedua yang identik harus ditempatkan pada posisi dalam arah melintang jembatan pada bentang lainnya.
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Beban garis terpusat p = 49 kN/m
Faktor beban dinamis FBD = 0.4
Beban BGT yang bekerja pada gelagar tengah PBGT = (1+FBD) p sg = 75.46 kN
Beban TD yang bekerja pada abutment adalah setengah dari panjang bentang, sehingga: 
Beban akibat beban TD WTD = (WBTR L / 2) + (PBGT/2) ng = 1859.88 kN

Gaya dalam akibat beban TD pada dasar abutment
Gaya vertikal VTD1 = WTD = 1859.88 kN
Gaya dalam akibat beban TD pada dasar pilecap
Gaya vertikal VTD2 = WTD = 1859.88 kN

Gaya rem harus diambil yang terbesar dari :
- 25% dari berat gandar truk desain atau,
- 5% dari berat truk rencana ditambah beban lajur terbagi rata BTR

FTB1 = 25% x 225
FTB2 = 5% x (Berat Truk + BTR)

Gaya ini harus diasumsikan untuk bekerja secara horizontal pada jarak 1800 mm diatas permukaan jalan pada
masing-masing arah longitudinal dan dipilih yang paling menentukan. Untuk jembatan yang dimasa depan
akan dirubah menjadi satu arah,  maka semua lajur rencana harus dibebani secara simultan pada saat 
menghitung besarnya gaya rem. 

Berat truk PT = 500 kN
Berat gandar truk wT = 225 kN
Jumlah lajur nL = 2
Jumlah gelagar ng = 7
25% dari berat gandar truk desain FTB1 = 25% x berat gandar truk = 16.071 kN
5% dari berat truk rencana + beban lajur terbagi rata FTB2 = 5% x ( PT nL + PBTR)/ng = 28.357 kN
Nilai beban rem terbesar FTB = 28.357 kN
Berat akibat beban TB WTB = FTB/2 ng = 99.25 kN
Gaya dalam akibat beban rem pada dasar abutment
Gaya horizontal HTB1 = WTB = 99.25 kN
Momen MTB1 = HTB1 H' = 618.3275 kNm
Gaya dalam akibat beban rem pada dasar pilecap
Gaya horizontal HTB1 = WTB = 99.25 kN
Momen MTB2 = HTB2 H = 786.06 kNm

Beban Rem (TB)
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Loading Combinations
Kuat I = 1.3 MS + 2MA + 1.25TA + 1.25PS + 1.8TD +1.8TB
Kuat II = 1.3 MS + 2MA + 1.25TA + 1.25PS + 1.4TD +1.4TB
Kuat III = 1.3 MS + 2MA + 1.25TA + 1.25PS
Ekstrem I = 1.3 MS + 2MA + 1.25TA + 1.25PS + EQ
Ekstrem II = 1.3 MS + 2MA + 1.25TA + 1.25PS + 0.5TD +0.5TB
Daya Layan I = MS + MA + TA + TA' + PS + TD + TB
Daya Layan II = MS + MA + TA + PS + 1.3TD + 1.3TB
Daya Layan III = MS + MA + TA + PS + 0.8TD + 0.8TB
Daya Layan IV = MS + MA
Service Gempa = MS + MA + TA + PS + TD + TB + 0.7EQ

Kombinasi beban abutment
Kuat I Daya Layan I Kuat I
Kuat II Daya Layan II Kuat II
Kuat III Daya Layan III Kuat III
Ekstrem I Daya Layan IV Ekstrem I
Ekstrem II Service Gempa Ekstrem II

Kombinasi beban pilecap

Gambar 3.30 Pembebanan Struktur Bawah
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BAB IV

ANALISIS STRUKTUR

4.1	 Analisis Struktur Atas

4.1.1 Set Analyze Options

Setelah memasukkan semua beban yang bekerja pada jembatan 80 meter ini, 

langkah penting selanjutnya yang harus dilakukan adalah melakukan pengecekan 

terhadap model jembatan yang telah dibuat. Untuk melakukannya, klik menu 

Analyze → Set Analyze Options, lalu pilih sesuai dengan gambar di bawah ini.

Gambar 4.1 Analysis Options

4.1.2 Running Model

Run Analysis pada SAP2000 adalah proses inti di mana model struktur yang 

telah dibuat, termasuk elemen seperti balok, kolom, pelat, dan beban dihitung 

secara numerik untuk menghasilkan respons struktur terhadap berbagai beban 

(seperti mati, hidup, gempa, atau angin). Proses ini melibatkan pemecahan 

persamaan keseimbangan statis atau dinamis menggunakan metode elemen hingga 

(finite element method), di mana SAP2000 membangun matriks kekakuan global, 

menerapkan beban, dan menghitung deformasi, gaya internal (momen, geser, aksial), 

serta reaksi tumpuan. Sebelum menjalankan analisis, pengguna harus memastikan 

model terkunci (locked) untuk mencegah perubahan data, dan memilih load cases 
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serta kombinasi beban yang relevan. Run Analysis dapat bersifat linier (untuk beban 

statis sederhana) atau nonlinier (untuk gempa atau buckling), dengan opsi paralel 

untuk mempercepat komputasi pada model kompleks. Untuk run analysis hanya 

klik tombol F5 → Run Now.

4.1.3 Cek Desain Baja

Steel Design Check adalah proses verifikasi kekuatan dan stabilitas elemen baja 

(kolom, balok, bracing) di SAP2000 setelah Run Analysis selesai. SAP2000 secara 

otomatis menghitung rasio interaksi (PMM Ratio) berdasarkan kombinasi beban. 

Biasanya akan ada indikator yang menunjukkan bahwa elemen-elemen masih di 

bawah rasio aman atau tidak. Untuk melakukan steel design check, caranya klik menu 

Design → Steel Frame Design → Start Design/Check of Structure.

Gambar 4.2 Steel Design/Check of Structure
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Gambar 4.3 Hasil Steel Design/Check of Structure

4.1.4 Cek Stress Ratio Baja

PMM Interaction Ratios adalah nilai rasio interaksi yang menunjukkan tingkat 

pemanfaatan kapasitas elemen baja terhadap kombinasi gaya aksial (P), momen 

lentur utama (M3), dan momen lentur minor (M2). Biasanya nilai rasio di bawah 

1 dikategorikan sebagai angka yang aman, sedangkan di atas 1 perlu melakukan 

desain ulang. Untuk melakukan pengecekan PMM Ratio caranya klik Ctrl + Shift + 

F5 lalu pilih PMM Interaction Ratios.

Gambar 4.4 Nilai PMM Ratios

Dapat dilihat dari gambar di atas, semua nilai PMM Ratios berada di bawah 1. 

Dengan kata lain desain jembatan 80 meter ini AMAN.
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4.1.5 Cek Lendutan

Lendutan adalah salah satu faktor yang penting untuk dilakukan pemeriksaan. 

Biasanya pengecekan dilakukan sebelum atau sesudah cek rasio PMM. Dalam 

jembatan, lendutan yang diizinkan untuk menjadi batas atas (lendutan izin) adalah 

sebesar L/800, dengan L adalah panjang bentang dalam milimeter. Dan nilai untuk 

lendutan izin itu sendiri adalah 80.000 mm/800 = 100 mm. Untuk memeriksa 

lendutan caranya dengan klik F6 lalu pilih kategori yang disyaratkan dalam SNI 

1725:2016 untuk pemeriksaan lendutan, atau dengan tabel klik CTRL + T → Analysis 

Results → Joint Output → Displacement. Berikut adalah tabel lendutan dari beberapa 

kombinasi pembebanan.

Tabel 4.1 Joint Displacement

Gambar 4.5 Lendutan Akibat Berat Sendiri (DL)
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Gambar 4.6 Lendutan akibat Beban LL (TT)

Gambar 4.7 Lendutan Akibat DL+LL (Untuk Kasus TT)

Gambar 4.8 Lendutan Akibat LL (Untuk Kasus TD)



64

Gambar 4.9 Lendutan Akibat DL+LL (Untuk Kasus TD)

Dapat dilihat pada tabel lendutan di atas bahwa lendutan yang terjadi akibat 

DL adalah 130,92 mm, akibat LL 70,03 mm, dan akibat dari DL + LL adalah 200,95 

mm. Maka dari itu diperlukan sebuah camber (lawan lendut) sebesar 1,5 kali dari 

total lendutan akibat DL dan LL. Tinggi camber yang diperlukan adalah 400 mm 

maka sisa camber akibat lendutan masih 199,05 cm. Dan dari sini lendutan yang 

terjadi hanya ditinjau dari beban hidup saja, yaitu 70,03 mm yang mana angka 

tersebut masih di bawah lendutan izin yaitu 100 mm. Dengan kata lain lendutan 

dikategorikan “AMAN”.

4.1.6 Analisis Elastomeric Bearing

Untuk melakukan analisis pada elastomeric bearing penulis menggunakan 

cara manual yang dibantu dengan Excel seperti ditunjukkan pada gambar di bawah.
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Gambar 4.10 Analisis Elastomeric Bearing

Gambar 4.11 Tampak Atas Elastomeric Bearing

Gambar 4.12 Tampak Samping Elastomeric Bearing
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4.1.7 Analisis Metal Deck

Untuk melakukan analisis pada metal deck, penulis menggunakan cara manual 

yang dibantu dengan Excel seperti ditunjukkan pada gambar di bawah.
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Gambar 4.13 Analisis Metal Deck
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4.2	 Analisis Struktur Bawah

Data abutment
Lebar abutment Babt = 1200 mm
Panjang abutment Pabt = 10400 mm
Tinggi abutment Habt = 4850 mm
Lebar pilecap Bpc = 6800 mm
Panjang pilecap Ppc = 12200 mm
Tinggi pilecap Hpc = 1600 mm
Tinggi total Htot = 7920 mm
Jumlah bentang gelagar Ng = 6
Panjang bentang Lb = 80 m

Data timbunan tanah
Tinggi timbunan tanah dibelakang abutment H = 6230 mm
Lebar timbunan tanah dibelakang abutment B = 2800 mm
Berat volume tanah γs	= 18 kN/m3

Kuat tekan beton fc' = 30 MPa
Berat volume beton bertulang γc	= 24 kN/m3

Modulus elastisitas beton Ec = 25742.9602 MPa

Momen inersia potongan melintang I = (1/12) Pabt Babt
3 = 1.4976E+12 mm4

Momen inersia efektif potongan melintang Ie = 0,7 I = 1.0483E+12 mm4

Luas potongan melintang timbunan tanah Atim = 16756000 mm2

Luas potongan melintang abutment Aabt = 7068000 mm2

Luas potongan melintang pilecap Apc = 9760000 mm2

Berat struktur atas Wu 2037.642 kN
Berat abutment Wabt = Aabt*Pabt*γc = 1764.1728 kN
Berat pilecap Wpc = Apc*Ppc*γc = 2857.728 kN
Berat struktur bawah Wb = Wabt + Wpc = 4621.9008 kN
Berat total struktur W = Wb + Wu = 6659.5428 kN
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V H M V H M
MS 3814.994 0 0 MS 6274.514 0 0
MA 282.4092 0 0 MA 282.4092 0 0
TA 0 1210.962 2514.765 TA 0 2295.78624 6060.876
PS 0 272.1264 847.6737 PS 0 405.8208 1607.05
TA' 0 0 0 TA' 2996.323 0 3144.641
TD 1859.88 0 0 TD 1859.88 0 0
TB 0 99.25 618.3275 TB 0 99.25 786.06
EQ 0 2792.254 11667.21 EQ 0 4041.53487 19399.1

Gaya dalam abutment (ULS) Gaya dalam pilecap (ULS)

V H M V H M
Kuat I 8872.094 2032.511 5316.038 Kuat I 12069.47 3555.6588 10999.82
Kuat II 8128.142 1992.811 5068.707 Kuat II 11325.52 3515.9588 10685.39
Kuat III 5524.31 1853.861 4203.049 Kuat III 8721.686 3377.0088 9584.908

Ekstrem I 5524.31 4646.115 15870.26 Ekstrem I 8721.686 7418.54367 28984.01
Ekstrem  II 6454.25 1903.486 4512.213 Ekstrem  II 9651.626 3426.6338 9977.938

Gaya dalam pilecap (SLS)

V H M
Daya Layan I 11413.13 2800.85704 11598.63
Daya Layan II 11971.09 2830.63204 11834.45
Daya Layan III 11041.15 2781.00704 11441.42
Daya Layan IV 6556.923 0 0

Service Gempa 11413.13 5629.93145 25178

Tabel 4.2 Kombinasi Beban dan Gaya Dalam yang Terjadi

4.2.1 Cek Kapasitas Abutment dengan SPColumn

Untuk perhitungan tulangan vertikal abutment dibantu dengan menggunakan 

software SPColumn. SPColumn adalah perangkat lunak rekayasa struktural untuk 

perancangan dan analisis bagian beton bertulang yang terkena beban aksial dan 

momen lentur. Bentuk yang bisa dimodelkan dapat berbentuk persegi panjang, 

bulat, atau tidak beraturan, dengan tata letak atau pola penguatan apa pun. Efek 

kelangsingan (slenderness) pun dapat dipertimbangkan. 

SPColumn biasa digunakan secara luas untuk desain dinding geser, shaft lift, 

inti bangunan, tiang jembatan, serta elemen rangka bangunan. spColumn dapat 

menganalisis bagian yang tidak dapat ditemukan pada diagram desain atau dihitung 

secara manual, yaitu diagram interaksi P-M dari uji uniaxial dan biaxial, serta grafik 

kontur momen Mx-My dari uji biaxial.

Langkah awal untuk melakukan analisis di spColumn adalah menentukan 

parameter project yang akan digunakan. Kode ACI 318-14 dan ASTM A615M dipilih 

karena standar yang digunakan di Indonesia, yaitu SNI 2847:2019 (Persyaratan 

Beton Struktural Untuk Bangunan Gedung dan Penjelasan) dan SNI 2052:2024 (Baja 
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Tulangan Beton) mengacu kedua kode itu. Setelah membuka software spColumn, 

pilih New Project → Project → General → Design code (pilih ACI 318-14) → Unit 

system (pilih Metric) → Bar set (pilih ASTM A615M) → Confinement (pilih Tied) → 

Section capacity (pilih Moment capacity). 

Untuk material abutment, direncanakan kuat tekan beton sebesar 30 MPa dan 

kuat leleh baja 420 MPa. Pilih Materials → Strength, f ’c - MPa  (ketik 30) → Strength, 

fy - MPa (ketik 420). Selanjutnya adalah menentukan pilihan analisis yang akan 

dilakukan. Analisis akan dilakukan ke sumbu Y, karena momen yang terjadi bekerja 

mengitari sumbu Y dan tidak mempertimbangkan kelangsingan. Pilih Run Options 

→ Run option (pilih Investigation) → Run Axis (pilih About Y-Axis)→ Consider 

Slenderness (pilih No)

Gambar Tampilan Awal spColumn

Gambar Layar Kerja spColumn
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Gambar Dialog Box Tab Project

Langkah selanjutnya adalah menentukan dimensi abutment dan penulangan 

vertikal. Dimensi abutment direncanakan memiliki ukuran 1200 x 10400 mm dengan 

selimut beton 75 mm karena beton kontak langsung dengan tanah. Tulangan utama 

struktur sekurang-kurangnya memiliki rasio minimum 1% dari luas penampang 

atau memiliki rasio maksimum 8% dari luas penampang. Tulangan direncanakan 

D32-150 pada arah X dan D32-140 arah Y. 

Lebar abutmen				    =  1200 mm

Jumlah tulangan sepanjang arah X	 =  (1200 - 75 - 75)/150 = 7 buah

Panjang abutmen			   = 10400 mm

Jumlah tulangan sepanjang arah Y	 =  (10400 - 75 – 75)/140 = 74 – 2 = 72 buah

Jumlah tulangan sepanjang arah Y dikurangi 2 karena masing-masing ujung 

tulangan sudah tercover oleh tulangan sepanjang arah x di spColumn. 

Pilih Section → Size → Width (ketik 1200) → Depth (ketik 10400) → Bar 

Arrangement → Type (pilih Sides Differents) → Reinforcement → No of Bars (ketik 

7 pada Top and Bot, ketik 72 pada Left and Right) → Bar size (pilih #32) → Clear 

Cover (ketik 75) → Cover Type → Clear cover to (pilih Transverse bars).

Gambar Icon Section
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Gambar Dialog Box Section

Selanjutnya adalah menentukan kombinasi pembebanan yang diterima oleh 

abutment. Nilai pembebanan diambil dari hasil perhitungan manual pada kondisi 

Ultimate Limit State (ULS). 

Tabel Gaya dalam abutment (ULS)

V H M

Kuat I 8872.094 2032.511 5316.038

Kuat II 8128.142 1992.811 5068.707

Kuat III 5524.31 1853.861 4203.049

Ekstrem I 5524.31 4646.115 15870.26

Ekstrem  II 6454.25 1903.486 4512.213

Pilih Load → Loads → Factored Loads → New → Input nilai pembebanan, Pu 

untuk beban vertikal, M(uy) untuk momen → ulangi hingga semua pembebanan 

terinput → OK.

Gambar Tab Icon Load
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Gambar Dialog Box Loads

Tahap akhir adalah melakukan analisis untuk mengetahui apakah kapasitas 

nominal struktur lebih besar daripada gaya yang terjadi. Jika beban yang terjadi 

lebih besar (ditunjukkan dengan nilai Capacity Ratio > 1), maka tulangan harus 

ditambah, mutu beton dinaikkan, atau dimensi diperbesar. Pilih Solve → lalu 

software akan melakukan running analysis → analysis selesai → PM (pilih +PM, 

karena nilai beban yang diinput positif ) → Cek apakah Capacity Ratio > 1 di masing-

masing pembebanan  → jika ada, maka desain tidak aman dan perlu dilakukan revisi 

kembali → jika tidak ada, maka desain yang telah dibuat aman dan sudah memenuhi 

standar yang berlaku.

Gambar Icon Solve
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Gambar Diagram PM Hasil Analisis spColumn

Desain tulangan geser abutment
Arah longitudinal
Mutu beton f'c = 35 MPa
Mutu baja fy = 420 MPa
Lebar penampang b = 10400 mm
Tebal penampang h = 1200 mm
Tinggi efektif de = 1125 mm
Faktor reduksi geser ϕv = 0.75
Gaya geser terfaktor Vu = 4646.1155 kN
Gaya geser nominal Vn = Vu / ϕv = 6194.8206 kN
Tulangan transversal yang ditinjau per 1 m s = 1000 mm

Kuat geser yang disumbangkan oleh beton
Kuat geser beton Vc = 1/6  f'c^0.5  b  de = 11536.3556 kN
Kuat geser beton terfaktor 0.5 ϕv Vc = 4326.1333 kN
Cek Pakai Perkuatan Geser Perlu

Kekuatan geser yang disumbangkan oleh tulangan Vs =Vn - Vc = -5341534.97 N
Luas tulangan Av = (Vs s)/(fy de) = -11304.8359 mm2

Luas tulangan minimum Avmin = 0.083 f'c^0.5 ((b s)/fy) = 12158.9525 mm2

Luas tulangan yang diambil Avreq = 12158.9525 mm2

Diameter tulangan Ds = 19 mm
Jarak antar tulangan vertikal sv = 300 mm
Jarak antar tulangan horizontal sh = 600 mm
Luas tulangan yang digunakan Avused = 0.25 PI Dŝ 2 (b/sh) (s/sv) = 16381.6604 mm2

Cek Avused > Areq OK
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Arah transversal
Gaya gempa akibat berat struktur bawah Htot = 0,5 As Wb = 635.3110 kN
Berat struktur atas Wu = 4101.6420 kN
Koefisien gempa elastik CsmA1 = 0.6498
Faktor modifikasi respon R = 1.5
Gaya gempa akibat berat struktur atas Hd = (CsmA1*Wu)/R = 1776.7766 kN
Total gaya gempa Heq = Htot+Hd = 2412.0876 kN
Gaya geser terfaktor Vu = 2412.0876
Faktor reduksi geser ϕv = 0.75
Gaya geser nominal Vn = Vu / ϕv = 3216.1168 kN
Tulangan transversal yang ditinjau per 1 m s = 1000 mm

Kuat geser yang disumbangkan oleh beton
Kuat geser beton Vc = 1/6  f'c^0.5  b  de = 11536.3556
Kuat geser beton terfaktor 0.5 ϕv Vc = 4326.1333
Cek Pakai Perkuatan Geser Minimum

Kekuatan geser yang disumbangkan oleh tulangan Vs =Vn - Vc = -11535605.6 N
Luas tulangan Av = (Vs s)/(fy de) = -24413.9801 mm2

Luas tulangan minimum Avmin = 0.083 f'c^0.5 ((b s)/fy) = 12158.9525 mm2

Luas tulangan yang diambil Avreq = 12158.9525 mm2

Diameter tulangan Ds = 16 mm
Jarak antar tulangan sh = 150 mm
Luas tulangan terpakai Avused = 0.25 PI Dŝ 2 (b/sh) = 13940.2938 mm2

Cek Avused > Areq OK

Perhitungan Daya Dukung Aksial

Shape = Circular Cu = 6 Nspt - (kPa) for CH or CL
Dimension = 0.4 m = 2.5 Nspt - (kPa) for SC, ML, or MH
Perimeter = 1.26 m = 2 Nspt - (kPa) for Clayshale (only for bore pile)
10D = 4 m qs = α*Cu for clay
4D = 1.6 m = 0,1*N-SPT for sand with small displacement (t/m2)
Area = 0.13 m2 = 0,2*N-SPT for sand  with large displacement and bore pile (t/m2)
Type = Driven qp = 9*Cu for clay
Interval = 2 m = 40*N-SPTavg < 1600 for sand - driven pile (t/m2)

= 7*N-SPTavg < 400 for sand - bore pile (t/m2)

Length

(m) USCS Classification Layer NSPT Cu α NSPTavg
Tip 

Resistance Qu Qall Qall 0,7*Qs Qpullout

kPa Local Cumulative (kN) (ton) (kN) (kN) (kN) (ton)
0 CL Clay CL 0 0 1.00 0 0.0 2.5 0.0 0.0 0.0 0 0.0 0.0 0 0
-2 CL Clay CL 5 30 0.94 71 71.2 2.3 33.9 105.1 42.1 4 49.8 6.0 6.0 2.21
-4 CL Clay CL 2 12 1.00 30 101.4 2.5 13.6 114.9 46.0 5 71.0 6.0 12.1 3
-6 CL Clay CL 3 18 1.00 45 146.6 3.5 20.4 167.0 66.8 7 102.6 6.0 18.1 5
-8 CL Clay CL 4 24 1.00 60 206.9 7.3 27.1 234.1 93.6 9 144.8 6.0 24.1 7
-10 SP Sand SP 20 0 1.00 101 307.5 11.3 565.5 872.9 349.2 35 215.2 6.0 30.2 10
-12 SP Sand SP 18 0 1.00 90 397.9 11.8 590.6 988.6 395.4 40 278.6 6.0 36.2 12
-14 CL Clay CL 5 30 0.94 71 469.1 13.0 33.9 503.1 201.2 20 328.4 6.0 42.2 15
-16 CL Clay CL 9 54 0.68 92 561.1 20.5 61.1 622.2 248.9 25 392.8 6.0 48.3 17
-18 GP Sand GP 50 0 1.00 251 812.5 28.5 1432.6 2245.0 898.0 90 568.7 6.0 54.3 25
-20 GP Sand GP 50 0 1.00 251 1063.8 36.3 1826.3 2890.1 1156.0 116 744.6 6.0 60.3 32
-22 GP Sand GP 50 0 1.00 251 1315.1 50.0 2513.3 3828.4 1531.4 153 920.6 6.0 66.4 39

Skin Friction Wp

PILE AXIAL CAPACITY BH-1

Soil Type Soil Properties Compression Capacity Pullout Capacity
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Shape = Circular Cu = 6 Nspt - (kPa) for CH or CL
Dimension = 0.4 m 2.5 Nspt - (kPa) for SC, ML, or MH
Perimeter = 1.26 m 2 Nspt - (kPa) for Clayshale (only for bore pile)
10D = 4 m qs = α*Cu for clay
4D = 1.6 m = 0,1*N-SPT for sand with small displacement (t/m2)
Area = 0.13 m2 = 0,2*N-SPT for sand  with large displacement and bore pile (t/m2)
Type = Driven qp = 9*Cu for clay
Interval = 2 m = 40*N-SPTavg < 1600 for sand - driven pile (t/m2)

= 7*N-SPTavg < 400 for sand - bore pile (t/m2)

Length

(m) USCS Classification Layer NSPT Cu α NSPTavg
Tip 

Resistance Qu Qall Qall 0,7*Qs Qpullout

kPa Local Cumulative (kN) (ton) (kN) (kN) (kN) (ton)
0 CL Clay CL 0 0 1.00 0 0.0 2.5 0.0 0.0 0.0 0 0.0 0.0 0 0
-2 CL Clay CL 5 30 0.94 71 71.2 2.7 33.9 105.1 42.1 4 49.8 6.0 6.0 2
-4 CL Clay CL 3 18 1.00 45 116.4 5.3 20.4 136.8 54.7 5 81.5 6.0 12.1 4
-6 CL Clay CL 13 78 0.50 98 214.5 10.5 88.2 302.7 121.1 12 150.1 6.0 18.1 7
-8 SP Sand SP 21 0 1.00 106 320.0 21.8 1093.3 1413.3 565.3 57 224.0 6.0 24.1 10

-10 SP Sand SP 50 0 1.00 251 571.4 33.5 1683.9 2255.2 902.1 90 399.9 6.0 30.2 17
-12 SP Sand SP 50 0 1.00 251 822.7 42.8 2148.8 2971.5 1188.6 119 575.9 6.0 36.2 24
-14 GP Sand GP 50 0 1.00 251 1074.0 50.0 2513.3 3587.3 1434.9 143 751.8 6.0 42.2 32
-16 GP Sand GP 50 0 1.00 251 1325.3 50.0 2513.3 3838.6 1535.4 154 927.7 6.0 48.3 39
-18 GP Sand GP 50 0 1.00 251 1576.7 50.0 2513.3 4089.9 1636.0 164 1103.7 6.0 54.3 46
-20 GP Sand GP 50 0 1.00 251 1828.0 50.0 2513.3 4341.3 1736.5 174 1279.6 6.0 60.3 53
-22 GP Sand GP 50 0 1.00 251 2079.3 50.0 2513.3 4592.6 1837.0 184 1455.5 6.0 66.4 61
-24 GP Sand GP 50 0 1.00 251 2330.6 50.0 2513.3 4843.9 1937.6 194 1631.5 6.0 72.4 68
-26 GP Sand GP 50 0 1.00 251 2582.0 50.0 2513.3 5095.2 2038.1 204 1807.4 6.0 78.4 75
-28 GP Sand GP 50 0 1.00 251 2833.3 50.0 2513.3 5346.6 2138.6 214 1983.3 6.0 84.4 82
-30 GP Sand GP 50 0 1.00 251 3084.6 50.0 2513.3 5597.9 2239.2 224 2159.2 6.0 90.5 90

Skin Friction Wp

PILE AXIAL CAPACITY BH-2

Soil Type Soil Properties Compression Capacity Pullout Capacity

Perhitungan Daya Dukung Lateral dengan LPILE

Perhitungan daya dukung lateral dilakukan dengan menggunakan program 

bantu LPILE. LPile adalah program khusus yang dapat menganalisis tiang pancang 

atau lubang bor yang dikenai beban lateral. Program ini menghitung defleksi, gaya 

geser, momen lentur, dan respons tanah berdasarkan kedalaman pada lapisan tanah. 

Program ini dilengkapi dengan fitur grafis untuk penyajian hasil dan fitur tambahan 

untuk analisis khusus. Lapisan tanah dan batuan dimodelkan menggunakan kurva 

transfer beban lateral (kurva p-y) yang dihasilkan secara internal oleh program. 

Sebagai alternatif, pengguna dapat memasukkan nilai kurva p-y untuk lapisan tanah 

tertentu. Program ini juga mengandung prosedur khusus untuk menghitung kurva 

p-y pada profil tanah berlapis. 

Gambar Layar Kerja LPILE
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Tahap awal dalam menggunakan LPILE adalah menentukan pengaturan 

analisis yang akan dilakukan. Pilih Program Options → Computational Analysis 

Mode (checklist Conventional Analysis mode) → Options for Response of Layered 

Soils (checklist Use Layering Correction) → Engineering Units (pilih SI Units) → 

Loading Type (Static Loading, Number of Cyclic Loading diisi 10) → OK.

Saat akan running analysis untuk terhadap kondisi layan/service, pilih Loading 

Type → Static Loading → OK. Saat akan running analysis untuk cek terhadap kondisi 

gempa, pilih Loading Type → Cyclic Loading → OK. 

Gambar Icon Program Options

Gambar Dialog Box Program Options

Tahap selanjutnya adalah menentukan jenis dan parameter tiang pancang 

yang digunakan. Pilih Pile Properties → Section Type (pilih Elastic Section with 

Specified Moment Capacity) → Dimensions and Properties → input nilai di Length 

of Section (kedalaman tiang) → Structural Shape (pilih Pipe) → input nilai Elas. 

Sect. Diam. dan Wall Thickness → Compute Mom. Of Inertia and Area → input 

momen tiang di Plas. Mom. Cap → Input nilai Elastic Mod. tiang → OK.
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Gambar Icon Pile Properties

Gambar Dialog Box Section Type

Gambar Dialog Box Dimensions and Properties

Tahap selanjutnya adalah memodelkan lapisan tanah. Parameter tanah yang 

digunakan diambil dari hasil uji N-SPT, dengan stratifikasi lapisan tanah sebagai 

berikut.



83

Tabel Parameter lapisan tanah

No
Kedalaman 

(m)
Jenis tanah N-SPT C

u
 (kPa) Ф (o) g' (kN/m^3)

1 0-8
Lempung 

kelanauan - soft
3 18 - 16.0

2 8-12 Pasir - medium 19 - 35 19.0

3 12-16
Lempung 

kelanauan - stiff
7 42 - 17.0

4 16-22 Gravel - hard 50 - 44 19.8

 

Pilih Soil Properties → Add Row → Input jenis tanah (misal Soft Clay) → 

Input kedalaman lapisan → input parameter lapisan tanah di Soil Properties → 

ulangi hingga semua lapisan ter input → OK.

Gambar Icon Soil Properties

 

Gambar Dialog Box Soil Layers

Tahap selanjutnya adalah memodelkan analisis tiang. LPILE bisa menganalisis 

tiang berdasarkan gaya geser yang diberikan, momen yang diberikan, atau defleksi 

tiang yang direncanakan. Berdasarkan Pasal 5.1.6.4. mengenai Defleksi Izin Struktur 

Fondasi pada Pembahasan Penyelenggaraan Keamanan Jembatan Khusus (KKJTJ), 

defleksi lateral tiang (fondasi) pada permukaan tanah dibatasi dengan ketentuan 

sebagai berikut.

Kondisi layan	 =  12 mm

Kondisi gempa	 =  25 mm
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Analisis akan dianalisis berdasarkan defleksi tiang yang terjadi, sehingga akan 

output yang didapatkan berupa gaya geser (shear force). Tiang dimodelkan sebagai 

free head. Pilih Pile-head Loading → Add Row → pilih (1) Displ. And Moment → 

pada Load Case 1, input nilai 0.012 → Add Row → pilih (1) Displ. And Moment → 

pada Load Case 2, input nilai 0.025 → OK.

Gambar Icon Pile-Head Loading

Gambar Dialog Box Pile-Head Loadings and Options

Tahap akhir adalah melakukan analisis tiang yang sudah dimodelkan dengan 

klik Run Analysis. Untuk melihat hasil analisis secara detail, pilih View Report. Untuk 

melihat visualisasi gaya yang dialami dan defleksi tiang, pilih icon  

atau View Results.

Gambar Icon Run Analysis

Gambar Icon Untuk Menampilkan Grafik Hasil Analisis

Gambar Icon View Report
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Gambar Hasil Analisis LPILE

REKAPITULASI PERHITUNGAN TIANG PANCANG
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Foundation diameter d = 40 cm
= 0.4 m

Distance between foundation s = 120 cm
Arc tan (d/s) Φ = 18.4349
Number of foundations in each rown1 = 5
Number of foundations in each columnn2 = 9
Group efficiency Eff = 0.654
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Cek Kondisi Layan P45 BH-1

Checking Compressive and Tensile Reactions on Foundation Piles

Pile Diameter = 0.4 m
Distance between Pile = 1.2 m
Load Comb. = Daya Layan II
P = 1197 ton
Wpc = 246 ton
V = P + Wpc

= 1443.1 ton
Mx = 0 tm
My = 1183 tm
Efficiency of foundation piles = 0.654
Compressive bearing capacity = 90 ton
Pullout capacity = 25 ton
Lateral capacity of pile = 9.7 ton

No x x^2 y y^2 V/n Mx*y/Σy
^2

My*x/Σx
^2

Qi Eff*Qall Qall > Qi Eff*Quplif

t

Quplift > 
Qi

H/n Hall Hall > 
H/n

1 0 0.0 0.0 0.0 32.1 0.0 0.0 32.1 58.7 OK 16.2 - 6.3 9.7 OK
2 0 0.0 1.2 1.4 32.1 0.0 0.0 32.1 58.7 OK 16.2 - 6.3 9.7 OK
3 0 0.0 2.4 5.8 32.1 0.0 0.0 32.1 58.7 OK 16.2 - 6.3 9.7 OK
4 0 0.0 3.6 13.0 32.1 0.0 0.0 32.1 58.7 OK 16.2 - 6.3 9.7 OK
5 0 0.0 4.8 23.0 32.1 0.0 0.0 32.1 58.7 OK 16.2 - 6.3 9.7 OK
6 0 0.0 -1.2 1.4 32.1 0.0 0.0 32.1 58.7 OK 16.2 - 6.3 9.7 OK
7 0 0.0 -2.4 5.8 32.1 0.0 0.0 32.1 58.7 OK 16.2 - 6.3 9.7 OK
8 0 0.0 -3.6 13.0 32.1 0.0 0.0 32.1 58.7 OK 16.2 - 6.3 9.7 OK
9 0 0.0 -4.8 23.0 32.1 0.0 0.0 32.1 58.7 OK 16.2 - 6.3 9.7 OK
10 1.35 1.8 0.0 0.0 32.1 0.0 9.7 41.8 58.7 OK 16.2 - 6.3 9.7 OK
11 1.35 1.8 1.2 1.4 32.1 0.0 9.7 41.8 58.7 OK 16.2 - 6.3 9.7 OK
12 1.35 1.8 2.4 5.8 32.1 0.0 9.7 41.8 58.7 OK 16.2 - 6.3 9.7 OK
13 1.35 1.8 3.6 13.0 32.1 0.0 9.7 41.8 58.7 OK 16.2 - 6.3 9.7 OK
14 1.35 1.8 4.8 23.0 32.1 0.0 9.7 41.8 58.7 OK 16.2 - 6.3 9.7 OK
15 1.35 1.8 -1.2 1.4 32.1 0.0 9.7 41.8 58.7 OK 16.2 - 6.3 9.7 OK
16 1.35 1.8 -2.4 5.8 32.1 0.0 9.7 41.8 58.7 OK 16.2 - 6.3 9.7 OK
17 1.35 1.8 -3.6 13.0 32.1 0.0 9.7 41.8 58.7 OK 16.2 - 6.3 9.7 OK
18 1.35 1.8 -4.8 23.0 32.1 0.0 9.7 41.8 58.7 OK 16.2 - 6.3 9.7 OK
19 2.7 7.3 0.0 0.0 32.1 0.0 19.5 51.5 58.7 OK 16.2 - 6.3 9.7 OK
20 2.7 7.3 1.2 1.4 32.1 0.0 19.5 51.5 58.7 OK 16.2 - 6.3 9.7 OK
21 2.7 7.3 2.4 5.8 32.1 0.0 19.5 51.5 58.7 OK 16.2 - 6.3 9.7 OK
22 2.7 7.3 3.6 13.0 32.1 0.0 19.5 51.5 58.7 OK 16.2 - 6.3 9.7 OK
23 2.7 7.3 4.8 23.0 32.1 0.0 19.5 51.5 58.7 OK 16.2 - 6.3 9.7 OK
24 2.7 7.3 -1.2 1.4 32.1 0.0 19.5 51.5 58.7 OK 16.2 - 6.3 9.7 OK
25 2.7 7.3 -2.4 5.8 32.1 0.0 19.5 51.5 58.7 OK 16.2 - 6.3 9.7 OK
26 2.7 7.3 -3.6 13.0 32.1 0.0 19.5 51.5 58.7 OK 16.2 - 6.3 9.7 OK
27 2.7 7.3 -4.8 23.0 32.1 0.0 19.5 51.5 58.7 OK 16.2 - 6.3 9.7 OK
28 -1.35 1.8 0.0 0.0 32.1 0.0 -9.7 22.3 58.7 OK 16.2 - 6.3 9.7 OK
29 -1.35 1.8 1.2 1.4 32.1 0.0 -9.7 22.3 58.7 OK 16.2 - 6.3 9.7 OK
30 -1.35 1.8 2.4 5.8 32.1 0.0 -9.7 22.3 58.7 OK 16.2 - 6.3 9.7 OK
31 -1.35 1.8 3.6 13.0 32.1 0.0 -9.7 22.3 58.7 OK 16.2 - 6.3 9.7 OK
32 -1.35 1.8 4.8 23.0 32.1 0.0 -9.7 22.3 58.7 OK 16.2 - 6.3 9.7 OK
33 -1.35 1.8 -1.2 1.4 32.1 0.0 -9.7 22.3 58.7 OK 16.2 - 6.3 9.7 OK
34 -1.35 1.8 -2.4 5.8 32.1 0.0 -9.7 22.3 58.7 OK 16.2 - 6.3 9.7 OK
35 -1.35 1.8 -3.6 13.0 32.1 0.0 -9.7 22.3 58.7 OK 16.2 - 6.3 9.7 OK
36 -1.35 1.8 -4.8 23.0 32.1 0.0 -9.7 22.3 58.7 OK 16.2 - 6.3 9.7 OK
37 -2.7 7.3 0.0 0.0 32.1 0.0 -19.5 12.6 58.7 OK 16.2 - 6.3 9.7 OK
38 -2.7 7.3 1.2 1.4 32.1 0.0 -19.5 12.6 58.7 OK 16.2 - 6.3 9.7 OK
39 -2.7 7.3 2.4 5.8 32.1 0.0 -19.5 12.6 58.7 OK 16.2 - 6.3 9.7 OK
40 -2.7 7.3 3.6 13.0 32.1 0.0 -19.5 12.6 58.7 OK 16.2 - 6.3 9.7 OK
41 -2.7 7.3 4.8 23.0 32.1 0.0 -19.5 12.6 58.7 OK 16.2 - 6.3 9.7 OK
42 -2.7 7.3 -1.2 1.4 32.1 0.0 -19.5 12.6 58.7 OK 16.2 - 6.3 9.7 OK
43 -2.7 7.3 -2.4 5.8 32.1 0.0 -19.5 12.6 58.7 OK 16.2 - 6.3 9.7 OK
44 -2.7 7.3 -3.6 13.0 32.1 0.0 -19.5 12.6 58.7 OK 16.2 - 6.3 9.7 OK
45 -2.7 7.3 -4.8 23.0 32.1 0.0 -19.5 12.6 58.7 OK 16.2 - 6.3 9.7 OK

Total 164.0 432.0
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Cek Kondisi Gempa P45 BH-1

Checking Compressive and Tensile Reactions on Foundation Piles Dynamic Condition

Pile Diameter = 0.4 m
Distance between Pile = 1.2 m
Load Comb. = Service Gempa
P = 1141 ton
Wpc = 246 ton
V = P + Wpc

= 1387.3 ton
Mx = 0 tm
My = 2518 tm
Efficiency of foundation piles = 0.654
Compressive bearing capacity*1,56 = 140.089 ton
Tensile bearing capacity*1,56 = 38.5369 ton
Lateral capacity of pile = 14.8 ton

No x x^2 y y^2 V/n Mx*y/Σy
^2

My*x/Σx
^2

Qi Eff*Qall Qall > Qi Eff*Quplif

t

Quplift > 
Qi

H/n Hall Hall > 
H/n

1 0 0.0 0.0 0.0 30.8 0.0 0.0 30.8 91.6 OK 25.2 - 12.5 14.8 OK
2 0 0.0 1.2 1.4 30.8 0.0 0.0 30.8 91.6 OK 25.2 - 12.5 14.8 OK
3 0 0.0 2.4 5.8 30.8 0.0 0.0 30.8 91.6 OK 25.2 - 12.5 14.8 OK
4 0 0.0 3.6 13.0 30.8 0.0 0.0 30.8 91.6 OK 25.2 - 12.5 14.8 OK
5 0 0.0 4.8 23.0 30.8 0.0 0.0 30.8 91.6 OK 25.2 - 12.5 14.8 OK
6 0 0.0 -1.2 1.4 30.8 0.0 0.0 30.8 91.6 OK 25.2 - 12.5 14.8 OK
7 0 0.0 -2.4 5.8 30.8 0.0 0.0 30.8 91.6 OK 25.2 - 12.5 14.8 OK
8 0 0.0 -3.6 13.0 30.8 0.0 0.0 30.8 91.6 OK 25.2 - 12.5 14.8 OK
9 0 0.0 -4.8 23.0 30.8 0.0 0.0 30.8 91.6 OK 25.2 - 12.5 14.8 OK
10 1.2 1.4 0.0 0.0 30.8 0.0 23.3 54.1 91.6 OK 25.2 - 12.5 14.8 OK
11 1.2 1.4 1.2 1.4 30.8 0.0 23.3 54.1 91.6 OK 25.2 - 12.5 14.8 OK
12 1.2 1.4 2.4 5.8 30.8 0.0 23.3 54.1 91.6 OK 25.2 - 12.5 14.8 OK
13 1.2 1.4 3.6 13.0 30.8 0.0 23.3 54.1 91.6 OK 25.2 - 12.5 14.8 OK
14 1.2 1.4 4.8 23.0 30.8 0.0 23.3 54.1 91.6 OK 25.2 - 12.5 14.8 OK
15 1.2 1.4 -1.2 1.4 30.8 0.0 23.3 54.1 91.6 OK 25.2 - 12.5 14.8 OK
16 1.2 1.4 -2.4 5.8 30.8 0.0 23.3 54.1 91.6 OK 25.2 - 12.5 14.8 OK
17 1.2 1.4 -3.6 13.0 30.8 0.0 23.3 54.1 91.6 OK 25.2 - 12.5 14.8 OK
18 1.2 1.4 -4.8 23.0 30.8 0.0 23.3 54.1 91.6 OK 25.2 - 12.5 14.8 OK
19 2.4 5.8 0.0 0.0 30.8 0.0 46.6 77.5 91.6 OK 25.2 - 12.5 14.8 OK
20 2.4 5.8 1.2 1.4 30.8 0.0 46.6 77.5 91.6 OK 25.2 - 12.5 14.8 OK
21 2.4 5.8 2.4 5.8 30.8 0.0 46.6 77.5 91.6 OK 25.2 - 12.5 14.8 OK
22 2.4 5.8 3.6 13.0 30.8 0.0 46.6 77.5 91.6 OK 25.2 - 12.5 14.8 OK
23 2.4 5.8 4.8 23.0 30.8 0.0 46.6 77.5 91.6 OK 25.2 - 12.5 14.8 OK
24 2.4 5.8 -1.2 1.4 30.8 0.0 46.6 77.5 91.6 OK 25.2 - 12.5 14.8 OK
25 2.4 5.8 -2.4 5.8 30.8 0.0 46.6 77.5 91.6 OK 25.2 - 12.5 14.8 OK
26 2.4 5.8 -3.6 13.0 30.8 0.0 46.6 77.5 91.6 OK 25.2 - 12.5 14.8 OK
27 2.4 5.8 -4.8 23.0 30.8 0.0 46.6 77.5 91.6 OK 25.2 - 12.5 14.8 OK
28 -1.2 1.4 0.0 0.0 30.8 0.0 -23.3 7.5 91.6 OK 25.2 - 12.5 14.8 OK
29 -1.2 1.4 1.2 1.4 30.8 0.0 -23.3 7.5 91.6 OK 25.2 - 12.5 14.8 OK
30 -1.2 1.4 2.4 5.8 30.8 0.0 -23.3 7.5 91.6 OK 25.2 - 12.5 14.8 OK
31 -1.2 1.4 3.6 13.0 30.8 0.0 -23.3 7.5 91.6 OK 25.2 - 12.5 14.8 OK
32 -1.2 1.4 4.8 23.0 30.8 0.0 -23.3 7.5 91.6 OK 25.2 - 12.5 14.8 OK
33 -1.2 1.4 -1.2 1.4 30.8 0.0 -23.3 7.5 91.6 OK 25.2 - 12.5 14.8 OK
34 -1.2 1.4 -2.4 5.8 30.8 0.0 -23.3 7.5 91.6 OK 25.2 - 12.5 14.8 OK
35 -1.2 1.4 -3.6 13.0 30.8 0.0 -23.3 7.5 91.6 OK 25.2 - 12.5 14.8 OK
36 -1.2 1.4 -4.8 23.0 30.8 0.0 -23.3 7.5 91.6 OK 25.2 - 12.5 14.8 OK
37 -2.4 5.8 0.0 0.0 30.8 0.0 -46.6 -15.8 91.6 - 25.2 OK 12.5 14.8 OK
38 -2.4 5.8 1.2 1.4 30.8 0.0 -46.6 -15.8 91.6 - 25.2 OK 12.5 14.8 OK
39 -2.4 5.8 2.4 5.8 30.8 0.0 -46.6 -15.8 91.6 - 25.2 OK 12.5 14.8 OK
40 -2.4 5.8 3.6 13.0 30.8 0.0 -46.6 -15.8 91.6 - 25.2 OK 12.5 14.8 OK
41 -2.4 5.8 4.8 23.0 30.8 0.0 -46.6 -15.8 91.6 - 25.2 OK 12.5 14.8 OK
42 -2.4 5.8 -1.2 1.4 30.8 0.0 -46.6 -15.8 91.6 - 25.2 OK 12.5 14.8 OK
43 -2.4 5.8 -2.4 5.8 30.8 0.0 -46.6 -15.8 91.6 - 25.2 OK 12.5 14.8 OK
44 -2.4 5.8 -3.6 13.0 30.8 0.0 -46.6 -15.8 91.6 - 25.2 OK 12.5 14.8 OK
45 -2.4 5.8 -4.8 23.0 30.8 0.0 -46.6 -15.8 91.6 - 25.2 OK 12.5 14.8 OK

Total 129.6 432.0



89

Cek Kondisi Layan P45 BH-2

Checking Compressive and Tensile Reactions on Foundation Piles

Pile Diameter = 0.4 m
Distance between Pile = 1.2 m
Load Comb. = Daya Layan II
P = 1197 ton
Wpc = 246 ton
V = P + Wpc

= 1443.1 ton
Mx = 0 tm
My = 1183 tm
Efficiency of foundation piles = 0.654
Compressive bearing capacity = 115 ton
Tensile bearing capacity = 22 ton
Lateral capacity of pile = 9.7 ton

No x x^2 y y^2 V/n Mx*y/Σy
^2

My*x/Σx
^2

Qi Eff*Qall Qall > Qi Eff*Quplif

t

Quplift > 
Qi

H/n Hall Hall > 
H/n

1 0 0.0 0.0 0.0 32.1 0.0 0.0 32.1 75.2 OK 14.4 - 6.3 9.7 OK
2 0 0.0 1.2 1.4 32.1 0.0 0.0 32.1 75.2 OK 14.4 - 6.3 9.7 OK
3 0 0.0 2.4 5.8 32.1 0.0 0.0 32.1 75.2 OK 14.4 - 6.3 9.7 OK
4 0 0.0 3.6 13.0 32.1 0.0 0.0 32.1 75.2 OK 14.4 - 6.3 9.7 OK
5 0 0.0 4.8 23.0 32.1 0.0 0.0 32.1 75.2 OK 14.4 - 6.3 9.7 OK
6 0 0.0 -1.2 1.4 32.1 0.0 0.0 32.1 75.2 OK 14.4 - 6.3 9.7 OK
7 0 0.0 -2.4 5.8 32.1 0.0 0.0 32.1 75.2 OK 14.4 - 6.3 9.7 OK
8 0 0.0 -3.6 13.0 32.1 0.0 0.0 32.1 75.2 OK 14.4 - 6.3 9.7 OK
9 0 0.0 -4.8 23.0 32.1 0.0 0.0 32.1 75.2 OK 14.4 - 6.3 9.7 OK
10 1.2 1.4 0.0 0.0 32.1 0.0 11.0 43.0 75.2 OK 14.4 - 6.3 9.7 OK
11 1.2 1.4 1.2 1.4 32.1 0.0 11.0 43.0 75.2 OK 14.4 - 6.3 9.7 OK
12 1.2 1.4 2.4 5.8 32.1 0.0 11.0 43.0 75.2 OK 14.4 - 6.3 9.7 OK
13 1.2 1.4 3.6 13.0 32.1 0.0 11.0 43.0 75.2 OK 14.4 - 6.3 9.7 OK
14 1.2 1.4 4.8 23.0 32.1 0.0 11.0 43.0 75.2 OK 14.4 - 6.3 9.7 OK
15 1.2 1.4 -1.2 1.4 32.1 0.0 11.0 43.0 75.2 OK 14.4 - 6.3 9.7 OK
16 1.2 1.4 -2.4 5.8 32.1 0.0 11.0 43.0 75.2 OK 14.4 - 6.3 9.7 OK
17 1.2 1.4 -3.6 13.0 32.1 0.0 11.0 43.0 75.2 OK 14.4 - 6.3 9.7 OK
18 1.2 1.4 -4.8 23.0 32.1 0.0 11.0 43.0 75.2 OK 14.4 - 6.3 9.7 OK
19 2.4 5.8 0.0 0.0 32.1 0.0 21.9 54.0 75.2 OK 14.4 - 6.3 9.7 OK
20 2.4 5.8 1.2 1.4 32.1 0.0 21.9 54.0 75.2 OK 14.4 - 6.3 9.7 OK
21 2.4 5.8 2.4 5.8 32.1 0.0 21.9 54.0 75.2 OK 14.4 - 6.3 9.7 OK
22 2.4 5.8 3.6 13.0 32.1 0.0 21.9 54.0 75.2 OK 14.4 - 6.3 9.7 OK
23 2.4 5.8 4.8 23.0 32.1 0.0 21.9 54.0 75.2 OK 14.4 - 6.3 9.7 OK
24 2.4 5.8 -1.2 1.4 32.1 0.0 21.9 54.0 75.2 OK 14.4 - 6.3 9.7 OK
25 2.4 5.8 -2.4 5.8 32.1 0.0 21.9 54.0 75.2 OK 14.4 - 6.3 9.7 OK
26 2.4 5.8 -3.6 13.0 32.1 0.0 21.9 54.0 75.2 OK 14.4 - 6.3 9.7 OK
27 2.4 5.8 -4.8 23.0 32.1 0.0 21.9 54.0 75.2 OK 14.4 - 6.3 9.7 OK
28 -1.2 1.4 0.0 0.0 32.1 0.0 -11.0 21.1 75.2 OK 14.4 - 6.3 9.7 OK
29 -1.2 1.4 1.2 1.4 32.1 0.0 -11.0 21.1 75.2 OK 14.4 - 6.3 9.7 OK
30 -1.2 1.4 2.4 5.8 32.1 0.0 -11.0 21.1 75.2 OK 14.4 - 6.3 9.7 OK
31 -1.2 1.4 3.6 13.0 32.1 0.0 -11.0 21.1 75.2 OK 14.4 - 6.3 9.7 OK
32 -1.2 1.4 4.8 23.0 32.1 0.0 -11.0 21.1 75.2 OK 14.4 - 6.3 9.7 OK
33 -1.2 1.4 -1.2 1.4 32.1 0.0 -11.0 21.1 75.2 OK 14.4 - 6.3 9.7 OK
34 -1.2 1.4 -2.4 5.8 32.1 0.0 -11.0 21.1 75.2 OK 14.4 - 6.3 9.7 OK
35 -1.2 1.4 -3.6 13.0 32.1 0.0 -11.0 21.1 75.2 OK 14.4 - 6.3 9.7 OK
36 -1.2 1.4 -4.8 23.0 32.1 0.0 -11.0 21.1 75.2 OK 14.4 - 6.3 9.7 OK
37 -2.4 5.8 0.0 0.0 32.1 0.0 -21.9 10.2 75.2 OK 14.4 - 6.3 9.7 OK
38 -2.4 5.8 1.2 1.4 32.1 0.0 -21.9 10.2 75.2 OK 14.4 - 6.3 9.7 OK
39 -2.4 5.8 2.4 5.8 32.1 0.0 -21.9 10.2 75.2 OK 14.4 - 6.3 9.7 OK
40 -2.4 5.8 3.6 13.0 32.1 0.0 -21.9 10.2 75.2 OK 14.4 - 6.3 9.7 OK
41 -2.4 5.8 4.8 23.0 32.1 0.0 -21.9 10.2 75.2 OK 14.4 - 6.3 9.7 OK
42 -2.4 5.8 -1.2 1.4 32.1 0.0 -21.9 10.2 75.2 OK 14.4 - 6.3 9.7 OK
43 -2.4 5.8 -2.4 5.8 32.1 0.0 -21.9 10.2 75.2 OK 14.4 - 6.3 9.7 OK
44 -2.4 5.8 -3.6 13.0 32.1 0.0 -21.9 10.2 75.2 OK 14.4 - 6.3 9.7 OK
45 -2.4 5.8 -4.8 23.0 32.1 0.0 -21.9 10.2 75.2 OK 14.4 - 6.3 9.7 OK

Total 129.6 432.0
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Cek Kondisi Gempa P45 BH-2

Checking Compressive and Tensile Reactions on Foundation Piles Dynamic Condition

Pile Diameter = 0.4 m
Distance between Pile = 1.2 m
Load Comb. = Service Gempa
P = 1141 ton
Wpc = 246 ton
V = P + Wpc

= 1387.3 ton
Mx = 0 tm
My = 2518 tm
Efficiency of foundation piles = 0.654
Compressive bearing capacity*1,56 = 179.4 ton
Tensile bearing capacity*1,56 = 34.32 ton
Lateral capacity of pile = 14.8 ton

No x x^2 y y^2 V/n Mx*y/Σy
^2

My*x/Σx
^2

Qi Eff*Qall Qall > Qi Eff*Quplif

t

Quplift > 
Qi

H/n Hall Hall > 
H/n

1 0 0.0 0.0 0.0 30.8 0.0 0.0 30.8 117.3 OK 22.4 - 12.5 14.8 OK
2 0 0.0 1.2 1.4 30.8 0.0 0.0 30.8 117.3 OK 22.4 - 12.5 14.8 OK
3 0 0.0 2.4 5.8 30.8 0.0 0.0 30.8 117.3 OK 22.4 - 12.5 14.8 OK
4 0 0.0 3.6 13.0 30.8 0.0 0.0 30.8 117.3 OK 22.4 - 12.5 14.8 OK
5 0 0.0 4.8 23.0 30.8 0.0 0.0 30.8 117.3 OK 22.4 - 12.5 14.8 OK
6 0 0.0 -1.2 1.4 30.8 0.0 0.0 30.8 117.3 OK 22.4 - 12.5 14.8 OK
7 0 0.0 -2.4 5.8 30.8 0.0 0.0 30.8 117.3 OK 22.4 - 12.5 14.8 OK
8 0 0.0 -3.6 13.0 30.8 0.0 0.0 30.8 117.3 OK 22.4 - 12.5 14.8 OK
9 0 0.0 -4.8 23.0 30.8 0.0 0.0 30.8 117.3 OK 22.4 - 12.5 14.8 OK
10 1.2 1.4 0.0 0.0 30.8 0.0 23.3 54.1 117.3 OK 22.4 - 12.5 14.8 OK
11 1.2 1.4 1.2 1.4 30.8 0.0 23.3 54.1 117.3 OK 22.4 - 12.5 14.8 OK
12 1.2 1.4 2.4 5.8 30.8 0.0 23.3 54.1 117.3 OK 22.4 - 12.5 14.8 OK
13 1.2 1.4 3.6 13.0 30.8 0.0 23.3 54.1 117.3 OK 22.4 - 12.5 14.8 OK
14 1.2 1.4 4.8 23.0 30.8 0.0 23.3 54.1 117.3 OK 22.4 - 12.5 14.8 OK
15 1.2 1.4 -1.2 1.4 30.8 0.0 23.3 54.1 117.3 OK 22.4 - 12.5 14.8 OK
16 1.2 1.4 -2.4 5.8 30.8 0.0 23.3 54.1 117.3 OK 22.4 - 12.5 14.8 OK
17 1.2 1.4 -3.6 13.0 30.8 0.0 23.3 54.1 117.3 OK 22.4 - 12.5 14.8 OK
18 1.2 1.4 -4.8 23.0 30.8 0.0 23.3 54.1 117.3 OK 22.4 - 12.5 14.8 OK
19 2.4 5.8 0.0 0.0 30.8 0.0 46.6 77.5 117.3 OK 22.4 - 12.5 14.8 OK
20 2.4 5.8 1.2 1.4 30.8 0.0 46.6 77.5 117.3 OK 22.4 - 12.5 14.8 OK
21 2.4 5.8 2.4 5.8 30.8 0.0 46.6 77.5 117.3 OK 22.4 - 12.5 14.8 OK
22 2.4 5.8 3.6 13.0 30.8 0.0 46.6 77.5 117.3 OK 22.4 - 12.5 14.8 OK
23 2.4 5.8 4.8 23.0 30.8 0.0 46.6 77.5 117.3 OK 22.4 - 12.5 14.8 OK
24 2.4 5.8 -1.2 1.4 30.8 0.0 46.6 77.5 117.3 OK 22.4 - 12.5 14.8 OK
25 2.4 5.8 -2.4 5.8 30.8 0.0 46.6 77.5 117.3 OK 22.4 - 12.5 14.8 OK
26 2.4 5.8 -3.6 13.0 30.8 0.0 46.6 77.5 117.3 OK 22.4 - 12.5 14.8 OK
27 2.4 5.8 -4.8 23.0 30.8 0.0 46.6 77.5 117.3 OK 22.4 - 12.5 14.8 OK
28 -1.2 1.4 0.0 0.0 30.8 0.0 -23.3 7.5 117.3 OK 22.4 - 12.5 14.8 OK
29 -1.2 1.4 1.2 1.4 30.8 0.0 -23.3 7.5 117.3 OK 22.4 - 12.5 14.8 OK
30 -1.2 1.4 2.4 5.8 30.8 0.0 -23.3 7.5 117.3 OK 22.4 - 12.5 14.8 OK
31 -1.2 1.4 3.6 13.0 30.8 0.0 -23.3 7.5 117.3 OK 22.4 - 12.5 14.8 OK
32 -1.2 1.4 4.8 23.0 30.8 0.0 -23.3 7.5 117.3 OK 22.4 - 12.5 14.8 OK
33 -1.2 1.4 -1.2 1.4 30.8 0.0 -23.3 7.5 117.3 OK 22.4 - 12.5 14.8 OK
34 -1.2 1.4 -2.4 5.8 30.8 0.0 -23.3 7.5 117.3 OK 22.4 - 12.5 14.8 OK
35 -1.2 1.4 -3.6 13.0 30.8 0.0 -23.3 7.5 117.3 OK 22.4 - 12.5 14.8 OK
36 -1.2 1.4 -4.8 23.0 30.8 0.0 -23.3 7.5 117.3 OK 22.4 - 12.5 14.8 OK
37 -2.4 5.8 0.0 0.0 30.8 0.0 -46.6 -15.8 117.3 - 22.4 OK 12.5 14.8 OK
38 -2.4 5.8 1.2 1.4 30.8 0.0 -46.6 -15.8 117.3 - 22.4 OK 12.5 14.8 OK
39 -2.4 5.8 2.4 5.8 30.8 0.0 -46.6 -15.8 117.3 - 22.4 OK 12.5 14.8 OK
40 -2.4 5.8 3.6 13.0 30.8 0.0 -46.6 -15.8 117.3 - 22.4 OK 12.5 14.8 OK
41 -2.4 5.8 4.8 23.0 30.8 0.0 -46.6 -15.8 117.3 - 22.4 OK 12.5 14.8 OK
42 -2.4 5.8 -1.2 1.4 30.8 0.0 -46.6 -15.8 117.3 - 22.4 OK 12.5 14.8 OK
43 -2.4 5.8 -2.4 5.8 30.8 0.0 -46.6 -15.8 117.3 - 22.4 OK 12.5 14.8 OK
44 -2.4 5.8 -3.6 13.0 30.8 0.0 -46.6 -15.8 117.3 - 22.4 OK 12.5 14.8 OK
45 -2.4 5.8 -4.8 23.0 30.8 0.0 -46.6 -15.8 117.3 - 22.4 OK 12.5 14.8 OK

Total 129.6 432.0
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Pemodelan pile cap di AFES 3.0

Pada pile cap jembatan, alur gaya dari struktur atas menuju kelompok tiang 

membentuk sistem tekan–tarik yang bersifat tiga dimensi dan sangat dipengaruhi 

oleh posisi tiang, eksentrisitas beban, serta kekakuan relatif elemen. Dalam 

konteks tersebut, AFES digunakan sebagai alat bantu untuk memodelkan dan 

mengevaluasi perilaku pile cap secara lebih mendekati kondisi aktual, terutama 

dalam mengidentifikasi respons geser satu arah, geser dua arah, serta distribusi 

reaksi tiang yang kritis terhadap keselamatan struktur.

Langkah pertama adalah menentukan informasi umum proyek, yang berisi 

data umum, data klien, dan data pekerjaan terkait proyek. Data umum mencakup 

nomor proyek, nama proyek, nama klien, nama lokasi, dan lainnya. Data klien 

mencakup nama manajer klien, alamat email, nomor telepon, dan faks, serta alamat. 

Data pekerjaan mencakup insinyur yang ditugaskan, supervisor, durasi proyek, 

dan tarif proyek yang harus digunakan program untuk proyek spesifik tersebut. 

Nomor Proyek dan Nama Struktur yang dimasukkan dalam Informasi Proyek akan 

ditampilkan sebagai header menu.

New Project → OK → Input Project Information → OK

Gambar Tampilan awal AFES
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Gambar Input Project Information

Langkah selanjutnya adalah menentukan Setting of Constant. Setting of 

Constant mencakup informasi desain yang dibutuhkan oleh AFES untuk merancang 

fondasi. Ini mencakup sejumlah parameter seperti kode desain, faktor keamanan, 

kapasitas dukung tanah, kapasitas tiang, bahan dan berat jenis, dan lain-lain.
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Setting of Constant

Gambar Icon Setting of Constant

Tab Code berisi pilihan standar desain yang bisa digunakan. Mengingat 

standar yang berlaku di Indonesia mengacu ke standar Amerika satuan unit yang 

umum dipakai adalah SI, maka pada bagian design code pilih American Concrete 

Institue (ACI 318 : SI). Pada bagian Applied Wind Load dan Applied Seismic Load, 

pilih American Society of Civil Engineers (ASCE 7-05). Setelah itu klik Save.

Gambar Tab Code di Setting of Constant

Selanjutnya, pilih tab Safety Factor untuk menentukan nilai faktor keamanan 

dari Sliding Force (Gaya Geser), Overturning Moment (Momen Guling), dan Uplift 

Force (Gaya Guling). Penentuan nilai faktor keamanan minimum masing-masing 

kondisi didasarkan pada SNI 8460 : 2017 tentang Persyaratan Perancangan Geoteknik 

pada Pasal 9.3.3. Nilai Friction Factor Soil to Concrete dapat diambil dari tan δ (sudut 

geser tanah). Setelah itu klik Save.
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Gambar Pasal 9.3.3 SNI 8460 : 2017.

Gambar Tab Safety Factor di Setting of Constant

Lalu pada tab Bearing Capacity of Soil, nilai Soil Bearing Capacity bisa 

dikosongkan karena desain fondasi yang digunakan adalah fondasi dalam. Lalu 

input nilai kohesi tanah dan kedalaman muka air tanah dan pilih Consider Buoyancy 

untuk mempertimbangkan gaya apung. Pada bagian Consider Passsive Soil Pressure 

pilih No karena diasumsikan di bagian depan kaki abutment tidak ada timbunan 

tanah yang menahan untuk desain yang konservatif. Setelah itu klik Save.
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Gambar Tab Bearing Capacity of Soil di Setting of Constant

Lalu pilih tab Capacity of Pile untuk menentukan jenis tiang, material tiang, dan 

kapasitas tiang. Pada perencanaan fondasi ini, fondasi yang dipilih merupakan tiang 

pancang dengan diameter 400 mm. Pada section Pile Type → Driven Prestressed 

Concrete Piles, setelah itu Pile Shape → Circle. Lalu input nilai Pile Diameter, 

Pile Thickness, Pile Length, Allowable Capacity, Pile Area, dan Elastic Modulus 

sesuai dengan spesifikasi dan perhitungan daya dukung tanah yang telah dihitung 

sebelumnya. Setelah itu klik Save.

Diameter tiang				    =  400 mm

Tebal tiang				    =  75 mm

Kedalaman tiang				   =  18000 mm

Daya dukung vertikal			   =  1140 kN

Daya dukung uplift (angkat)		  =  310 kN

Daya dukung lateral			   =  69.5 kN

Modulus elastisitas 			   =  

						      =   = 33892181 kN

Luas tiang				    =   = 

						      =  125663 mm2 = 0.1256 m2
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Gambar Spesifikasi Tiang Pancang yang Digunakan

Gambar Tab Capacity of Pile di Setting of Constant

Lalu pilih tab Material and Unit Weight untuk menentukan parameter material 

beton dan baja tulangan. Parameter yang harus diisi adalah compressive strength 

of concrete, yield strength of reinforcement, unit weight, using bars, dan modulus 

of elasticity. Perlu diperhatikan bahwa satuan di input modulus elastisitas adalah 

kN/mm2. Untuk penentuan Using Bar Type dapat menggunakan JIS G 3112 (code 

Jepang), karena code ini menggunakan satuan diameter yang di mana sama dengan 

dimensi satuan baja tulangan di Indonesia, dan juga merupakan salah satu referensi 

standar baja tulangan di Indonesia selain ASTM A615M. Penentuan kuat leleh baja 

tulangan tetap didasarkan pada SNI 2052 : 2024 tentang Baja Tulangan Beton.

Mutu Pile Cap	  (f
c
’)		  =  30 MPa (N/mm2)

Mutu lantai kerja (f
c
’)		  =  10 MPa (N/mm2)

Kuat leleh tulangan		  =  BJTS 420 = 420 MPa (N/mm2)

Berat volume beton		  =  24 kN/m3

Berat volume tanah		  =  18 kN/m3
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Modulus elastisitas baja		 =  200.000 MPa (N/mm2) = 200 kN/mm2

Modulus elastisitas beton	 =   =  

					     =  25742.965 N/mm2 = 25.74 kN/mm2

Gambar Tab Material and Unit Weight di Setting of Constant

Lalu pilih tab Concrete Covers untuk menentukan tebal selimut beton dan 

panjang kedalaman tiang yang masuk ke pile cap. Untuk tebal lapisan selimut 

beton digunakan sebesar 75 mm karena beton dicor secara permanen dan kontak 

langsung dengan tanah (Pasal 20.6.1.3.1 SNI 2847:2019), sedangkan untuk panjang 

tiang tertanam ke pile cap diambil 250 mm.
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Gambar Tab Concrete Covers di Setting of Constant

Setelah semua parameter sudah di definisikan, Save → Close.
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Creating a New Structure

Setiap data input dan output dapat disimpan dalam Basis Data AFES sesuai 

dengan proyek, yang meningkatkan efisiensi kerja dalam pengendalian informasi 

proyek. Seorang engineer dapat membuat file untuk proyek baru, menggunakan 

kembali data dari proyek yang telah dilakukan sebelumnya, atau menghapus data 

lama dan tidak terpakai tergantung kepentingan pengguna. Berikut adalah sistem 

hierarki dari alur data AFES.

Gambar Sistem Hierarki Alur Data AFES.

Untuk membuat structure baru sebagai langkah awal mendesain fondasi, pilih  

File → Create New Structure Name atau klik icon di toolbar. Setelah dialog box 

terbuka, ketik nama structure (Pile Cap Abutment) → New.

Gambar Icon Create New Structure Name
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Gambar Dialog Box Add Create New Structure Name

Gambar Tampilan Structure yang sedang Digunakan
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Design Parameters

Langkah selanjutnya adalah pendefinisian geometri. Hal ini diperlukan 

untuk menentukan jumlah node dan koordinat struktur. Node-node tersebut dapat 

didefinisikan secara manual melalui perintah “Add” atau melalui pengaturan array 

menggunakan perintah “Wizard (New)”. Pile Cap akan dimodelkan dengan titik 

pusat massa berada di koordinat (0,0), pilih Design Parameters → Geometry Data 

→ Add → New → Save → Close.

Gambar Icon Geometry Data

Gambar Dialog Box Geometry Data

Langkah selanjutnya adalah mengelompokkan fondasi melalui perintah 

Assign Foundation Grouping. Setiap stuktur yang dibuat harus di-groupping untuk 

menentukan pemodelan struktur yang akan dibuat. Perintah ini juga bisa digunakan 

untuk mengelompokkan fondasi pada model dengan lebih dari satu fondasi. 

Fondasi dengan kombinasi beban yang sama disarankan untuk digabungkan 

dalam satu grup. Fondasi dengan nama grup yang berbeda tidak selalu berarti 
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mereka juga memiliki pengaturan yang berbeda. Data yang didefinisikan dalam 

perintah Setting of Constant tetap sama selama mereka termasuk dalam model yang 

sama. Hanya beberapa fitur yang berbeda untuk setiap grup, seperti kasus beban 

dan kombinasi beban.

Jenis fondasi yang tersedia adalah sebagai berikut:

Gambar Jenis Fondasi yang Tersedia di AFES 3.0

Pada perencanaan ini, pile cap didesain berpenampang miring (sloped) 

yang bertujuan untuk menahan gaya geser tinggi di dekat tiang dan menghemat 

penggunaan material beton. Design Parameters → Assign Foundation Grouping → 

New → Group Name (ketik nama grup) → Group Type (pilih Slope) →  pilih Pile fdn.

Gambar Icon Assign Foundation Grouping

Lalu untuk memilih node yang akan di-assign, pilih node di using node list → 

klik icon > → Save → Close.
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Gambar Dialog Box Assign Foundation Grouping

Gambar Dialog Box Assign Foundation Grouping

Langkah selanjutnya adalah menentukan dimensi Pile Cap di Feature Data. 

Perintah ini digunakan untuk mendefinisikan dimensi dan parameter lain yang 

diperlukan untuk fondasi dan pier. Hal ini tidak hanya berguna untuk fungsi desain 

dan analisis tetapi juga untuk perkiraan jumlah material. Pada pemodelan ini yang 

akan dimodelkan hanya Pile Cap, maka tab menu pier diabaikan/dikosongkan. Pilih  

Design Parameters → Feature Data → lalu isi dimensi sesuai dengan perencanaan 

→ Save → Close.
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Gambar Icon Feature Data

Gambar Dimensi Rencana Pile Cap

Setelah dimensi struktur ditentukan, maka hasil akan ditampilkan dalam detail 

gambar.
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Gambar Tampilan Pile Cap

Selanjutnya, menentukan penulangan Pile Cap dengan menggunakan 

perintah Reinforcement. Perintah Reinforcement digunakan untuk menetapkan 

ukuran dan jarak tulangan pada tiang dan fondasi. Ukuran dimensi baja tulangan 

bergantung pada kode desain yang ditetapkan dalam perintah Setting of Constant. 

Pilihan susunan batang penguatan tersedia dalam opsi Footing. Susunan tulangan 

fondasi biasanya sejajar dengan sumbu X dan Y, kecuali untuk modul tipe cincin 

Tank1 dan Tank2 yang memiliki arah radial dan longitudinal. Tulangan pada Pile 

Cap direncanakan menggunakan D22-150 (tulangan atas) dan D25-150 (tulangan 

bawah) pada arah X, dan D19-150 (tulangan atas dan bawah) pada arah Y. Pilih 

Design Parameters → Reinforcement Data → Footing → isi dimensi sesuai dengan 

perencanaan → Save → Close.

Gambar Icon Reinforcement
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Gambar Rencana Penulangan Pile Cap

Langkah selanjutnya adalah menentukan layout pile melalui perintah Layout 

Pile. Praktik umum yang digunakan untuk jarak antar pile adalah 2,5 – 3,5 D. 

Karena ukuran pile yang digunakan adalah 400 mm, maka untuk jarak antar pile 

yang digunakan adalah 1200 mm. Pilih Design Parameters → Layout of Pile → 

Coordinates → Origin Point (pilih Middle Center (MC)) → Pile Name (pilih pile 

yang telah didefinisikan) → Add → Masukkan koordinat masing-masing pile → 

Save → Close.

Koordinat pile yang digunakan adalah sebagai berikut.

Tabel Koordinat Pile dalam satuan milimeter

No X Y No X Y

1 0 0 23 2400 4800

2 0 1200 24 2400 -1200

3 0 2400 25 2400 -2400

4 0 3600 26 2400 -3600

5 0 4800 27 2400 -4800

6 0 -1200 28 -1200 0

7 0 -2400 29 -1200 1200

8 0 -3600 30 -1200 2400

9 0 -4800 31 -1200 3600

10 1200 0 32 -1200 4800
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No X Y No X Y

11 1200 1200 33 -1200 -1200

12 1200 2400 34 -1200 -2400

13 1200 3600 35 -1200 -3600

14 1200 4800 36 -1200 -4800

15 1200 -1200 37 -2400 0

16 1200 -2400 38 -2400 1200

17 1200 -3600 39 -2400 2400

18 1200 -4800 40 -2400 3600

19 2400 0 41 -2400 4800

20 2400 1200 42 -2400 -1200

21 2400 2400 43 -2400 -2400

22 2400 3600 44 -2400 -3600

45 -2400 -4800

Gambar Icon Layout Piles

Gambar Dialog Box Layout of Piles Setelah Diberi Koordinat

Tahap akhir sebelum analisis adalah penentuan pembebanan yang diatur 

dalam perintah Loads and Combination. Penentuan kombinasi pembebanan untuk 

perhitungan penulangan pile cap dan cek terhadap one way & two way shear diambil 
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dari kombinasi Kuat I - III dan Ekstrem I - II. Untuk menentukan pembebanan, 

langkah awal adalah menentukan Load Case. Pilih Design Parameters → Load 

Case/Combination → Set Load Case → New → Name (edit nama Load Case, misal 

LRFD-1) → Load Case Description (edit nama deskripsi, misal Kuat 1) → Save → 

New → Ulangi sampai semua Load Case diinput → Save → Close.

Gambar Icon Loads & Combination

Gambar Dialog Box Loads & Combination

Gambar Dialog Box Set Load Case
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Langkah selanjutnya adalah menentukan Load Case yang digunakan dalam 

analisis. Pilih Design Parameters → Load Case/Combination → Load Case → 

Unassigned Load Case → Pilih Load Case yang digunakan (misal LRFD-1) → Save 

→ Lalu ulangi hingga semua Load Case ter assign → Save. 

Gambar Dialog Box Load Case dengan Load Case yang Telah Diinput

Jika sudah, input nilai beban sesuai dengan perhitungan yang sudah dilakukan. 

Kombinasi beban yang dipilih adalah kombinasi Ultimate Limit State (ULS). 

Perlu diperhatikan arah beban yang akan digunakan, harus disesuaikan dengan 

pemodelan dan sumbu gaya di AFES. Gaya vertikal dimodelkan ke arah sumbu Z 

dengan nilai minus, gaya horizontal dimodelkan ke arah sumbu X, dan momen 

dimodelkan mengitari sumbu Y

Tabel Gaya dalam pile cap (ULS)

V H M

Kuat I 12069.47 3555.6588 10999.82

Kuat II 11325.52 3515.9588 10685.39

Kuat III 8721.686 3377.0088 9584.908

Ekstrem I 8721.686 7418.54367 28984.01

Ekstrem  II 9651.626 3426.6338 9977.938
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Untuk input pembebanan di AFes, pilih Load Case → Assigned Load Case → 

Pilih Load Case yang digunakan (misal LRFD-1) → Input pembebanan pada Fx 

(Beban Horizontal), Fz (Beban Vertikal), dan My (Momen) → Save  → Pilih Load 

Case selanjutnya → Ulangi sampai semua beban diinput → Save → Close.

Gambar Dialog Box Load Case dengan Beban yang Telah Diinput

Tahap selanjutnya adalah membuat Load Combination. AFES sendiri 

menyediakan dua opsi pengecekan, yaitu terhadap stabilitas (Stability) dan cek 

terhadap perkuatan serta punching shear (Reinforcement/Shear). Pada perencanaan 

pile cap ini, hanya akan menggunakan pengecekan terhadap Reinforcement/Shear, 

karena cek terhadap stabilitas sudah dilakukan di perhitungan manual (terhadap 

tekan, tarik, dan lateral). Pilih Design Parameters → Load Case/Combination → 

Load Combination → New → Pilih Load Case (misal LRFD-1) → Ketik nama/nomor 

di Name (L/C#) → Pilih > → Pilih Reinforcement/Shear → Save → Ulangi hingga 

Load Case Terakhir → Save → Close.
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Gambar Dialog Box Load Combination

Gambar Dialog Box Load Combination dengan Semua Combo Terdefinisi

Load Combination yang telah di input dapat di cek arah gayanya untuk 

memastikan arah gayanya benar. Pada tampilan layar kerja AFES, klik pada icon 

sesuai gambar berikut. 

Gambar Layar Kerja AFES
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Tahap terakhir dalam pemodelan di AFES adalah melakukan analisis. Analisis 

dilakukan untuk mengetahui gaya-gaya yang bekerja, kebutuhan tulangan, stabilitas 

fondasi, cek terhadap one way shear dan two way shear, dan lain-lain. Pilih icon 

Foundation Analysis/Design → Footing Design → Atur sesuai kebutuhan → Pada 

Tab Contents, Un-check poin 4. Check of Stability → Analysis.

Gambar Icon Foundation Analysis/Design

Gambar Dialog Box Foundation Analysis/Design
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Gambar Dialog Box Foundation Analysis/Design pada Tab Contens

Setelah Analysis dilakukan, pilih Report untuk melihat laporan keseluruhan 

dari hasil analisis. Untuk melihat summary dari hasil analisis pilih Close. Untuk 

kembali ke layar kerja AFES, klik icon  di tampilan layar. Apabila pada summary 

hasil analisis pada semua kondisi sudah “OK”, maka desain dapat dikatakan aman. 

Gambar Dialog Box Foundation Analysis/Design Setelah Running Analysis
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Gambar Dialog Box Summary Hasil Analisis
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